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كليات
بعد از ايجاد صفحه جديد و انتخاب واحد اندازه‌گيري مي‌توانيد طراحي را ش��روع کنيد. 
با توجه به نوع شکلي که مي‌خواهيد آن را ترسيم نماييد در جعبه ابزار FreeHand مي‌توانيد 
ابزار مورد نظر را انتخاب كنيد. با اس��تفاده از ابزارهاي ترس��يمي در  FreeHand MX مي‌توان 
اش��کال و تصاوير مختلفي را ايجاد کرد. هر کدام از‌ اين‌ابزارها، قابليت‌هاي مختلفي دارند که 

در اين‌جا به شرح کامل آن‌ها خواهيم پرداخت.   
1-5 ابزار Pen و تنظيمات آن 

براي رسم خطوط صاف و منحني از ابزار  Pen استفاده مي‌شود. هنگام استفاده از اين ابزار 
در هر قسمتي از صفحه که کليک کنيد يک گره )لنگر( ايجاد مي‌شود و با متصل شدن اين 

گره‌ها به يكديگر مسير مورد نظر به‌وجود مي‌آيد.
Pen 1-1-5 ترسيم مسير صاف با استفاده از ابزار

1- از جعبه ابزارTools  ابزار Pen را برگزينيد.
 توجه: P كليد ميانبر ابزار Pen است.

1- با ماوس روي قس��متي از صفحه که مي‌خواهيد نقطه ش��روع خط باشد، کليک کنيد 
در اين حالت يک مستطيل توخالي نمايان مي‌شود.

2- در قسمتي از صفحه که مي‌خواهيد نقطه دوم خط باشد، کليک کنيد.
3- وقتي رس��م مس��ير پايان يافت، کافي اس��ت فقط دابل کليک کنيد ي��ا کليد Tab  را 

بفشاريد تا مسير از حالت انتخاب خارج شود.

Pen شکل 1-5 رسم مسير صاف با ابزار

 نکته: با نگه داش��تن کليد Shift مي‌توانيد خطوطي با زاويه °45 يا عمود ايجاد 
کنيد.

Pen 2-1-5 ترسيم مسير منحني با استفاده از ابزار

1- از جعبه ابزار Tools ابزار Pen را انتخاب کنيد.
2- با ماوس روي قس��متي از صفحه که مي‌خواهيد نقطه اول منحني باش��د کليک کرده 
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و درگ کنيد و بدون اينك‌ه آن‌را رها كنيد، ماوس را جابه‌جا كنيد در نتيجه دس��تگيره‌هاي 
کنترل ايجاد مي‌شود. 

3- مكان بعدي را انتخاب كرده و مجدداً مانند مورد 2 عمل كنيد تا نقطه دوم )گره فعال( 
ايجاد شود. به اين صورت مي‌توانيد مسير منحني را با هر تعداد انحنا داشته باشيد.

شکل 2-5 ترسيم يک منحني

4- ب��ا درگ و تغيير مکان اش��اره‌گر ماوس مي‌توانيد جهت و ق��وس انحنا را تغيير دهيد 
)شكل 5-3(.

5- هنگامي که مسير پايان يافت کليد Tab را بفشاريد يا کليد Ctrl را نگه داشته و کليک 
کنيد تا مسير از حالت انتخاب خارج شود.   	                                                                                       

شکل 3-5  تغيير جهت و قوس منحني   

 نکته:  با استفاده از ابزار Pen مي‌توانيد يک مسير بسته نيز ايجاد کنيد، براي اين 
منظور بايد پس از تعيين نقطه انتهايي، اش��اره‌گر را روي نقطه شروع قرار دهيد تا يک دايره 

کوچک در کنار اشاره‌گر ظاهر شود سپس کليک کنيد )شكل 5-4(.
هنگام حذف يگ گره، همراه با اشاره‌گر ماوس يک علامت منفي )-( و هنگام اضافه کردن 

گره، کنار اشاره‌گر ماوس علامت مثبت )+( نمايان مي‌شود.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - هـ
100

 نکت�ه: ب��راي ايجاد يک منحن��ي برآمده هنگامي که مي‌خواهيد دس��تگيره‌هاي 
کنترل را تغيير اندازه يا تغيير جهت دهيد، از کليد Alt  استفاده کنيد )شكل 5-5(.

  

شکل 4-5 ايجاد يک مسير بسته با ابزار Pen              شکل 5-5 رسم منحني برآمده

 نکته:  براي رس��م تصاوير وارد شده به محيط FreeHand )تصاوير اسکن شده( از 
ابزار Pen نيز مي‌توان استفاده کرد.

 نکته: 
براي ويرايش يک مسير منحني پس از رسم آن، توسط ابزارPointer  روي هريک از 

نقاط منحني کليک کنيد تا دستگيره‌هاي کنترل آن نقطه نمايان شوند.

 نکت�ه: فش��ردن کليد Alt هنگام اس��تفاده از ابزار Pointer، س��بب کپي مس��ير 
مي‌شود.

 زماني که براي قرار دادن نقطه روي صفحه با ابزار Pen کليک مي‌کنيد، يک نقطه گوشه
)Corner Point( ايجاد مي‌شود که به شکل مربع است.

هنگام اس��تفاده از ابزار Pen وقتي درگ مي‌کنيد يک نقطه منحني )Curve Point( ايجاد 
مي‌ش��ود که به ش��کل دايره اس��ت. به نقاطي که براي اتصال هموار يک خط راس��ت به يک 
منحني ايجاد مي‌ش��ود، نقاط اتصال‌دهنده )Connector Point( مي‌گويند که با گرفتن کليد 
Alt و کليک راس��ت به‌وجود مي‌آيد و به شکل مثلث ديده مي‌شود ولي بعد از خارج شدن از 

حالت انتخاب به مربع تبديل مي‌شود )شکل 5-6(.
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شکل 6-5 نمايش انواع نقاط 

مثال 1: به منظور آشنايي بيشتر با نقاط اتصال دهنده شکل 7-5 را رسم کنيد.

شکل 7-5 رسم شکل با کمک نقطه اتصال دهنده

مراحل انجام کار به صورت زير است:
1- نقط��ه a را ب��ا کليک روي صفحه ق��رار داده و درگ کنيد، س��پس در نقطه b کليک 

کنيد.
2- مانند مرحله قبل درگ کرده روي نقطه c کليک کنيد.

3- براي رسم مسير منحني cd روي نقطه d کليک کرده و بدون رها کردن کليد ماوس 
با حرکت دادن دستگيره‌هاي کنترل، منحني را به وجود آوريد.

4- براي رسم پاره‌خط بعدي به يک خط صاف نياز داريد. اگر روي نقطه e کليک کنيد، 
يک خط منحني به‌وجود مي‌آيد. در اين قسمت براي رسم يک خط صاف به يک نقطه اتصال 
دهنده نياز داريد؛ چنانچه براي رس��م مس��ير منحني cd در نقطه d کليک کنيد، بايد کليد

 Alt را همزمان پايين نگه داريد تا اين نقطه به نقطه اتصال‌دهنده تبديل شود؛ در اين لحظه 

دس��تگيره کنترل در سمت راست ناپديد مي‌شود؛ س��پس در نقطه e کليک کرده و مسير را 
ببنديد.

•گره‌هاي موجود در مس��يرها قابل تبديل به يکديگر هستند يعني مي‌توان يک نقطه  	
گوش��ه را به نقطه منحني و برعکس تبديل کرد. همچنين مي‌توان کمان‌ها را نيز به 
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ــتفاده مي شود. اين  ــتقيم تبديل کرد؛ براي اين منظور از پنل Object اس خطوط مس
پنل، اطلاعاتي در مورد نقطه و مسير انتخاب شده ارايه مي دهد.                                                                                                                    

 مثال 2: شکل 8-5 را با استفاده از ابزار Pen رسم کنيد.

شکل 5-8

1- ابتدا يک مسير بيضي با 8 گره توسط ابزار Pen رسم کنيد.
ــمت دم ماهي قرار دهيد تا يک  2- ابزار Pen را روي گره هاي س
ــود. حال با کليک ماوس گره  ــت منفي )-( در کنار آن ظاهر ش علام

مربوطه را حذف کنيد. چنين شکلي خواهد شد. 
براي دم مي توانيد با کليک و درگ به سمت بالا از روي انتهاي دم رسم کنيد.

ــاره گر  Penرا در  ــمت دهان ماهي بايد گره اضافه کنيد، براي اين منظور اش 3- براي قس
قسمت موردنظر روي مسير قرار دهيد تا يک علامت مثبت )+( در کنار آن ظاهر شود. اکنون 
کافي است کليک کنيد تا يک گره به مسير اضافه شود و با درگ کردن، دهان ماهي را رسم 

کنيد.
Pen 3-1-5 تنظيمات ابزار

ــود. انتخاب  ــکل 9-5( باز مي ش ــا دابل کليک روي ابزار Pen کادرمحاوره Pen Tool )ش ب
ــيم با ابزار Pen پيش نمايشي از مسير  ــود تا هنگام ترس گزينهShow Pen Preview باعث مي ش

نشان داده شود.

Pen Tool شکل 9-5 کادر محاوره
تمرين 1: شکل 10-5 را با استفاده از ابزار Pen رسم کنيد.

  

شکل 5-10 
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 نکته: با استفاده از ابزارهاي انتخاب )Pointer و Sub Select( مي‌توانيد نقاط گره‌اي 
را انتخاب و سپس اصلاح كنيد.

Bezigon 2-5 ابزار ترسيم
اب��زار Bezigon در گ��روه ابزارهاي Pen قرار دارد و براي رس��م خط صاف يا منحني مورد 
اس��تفاده قرار مي‌گيرد. اين ابزار همانند ابزار Pen عمل مي‌کند با اين تفاوت که توس��ط ابزار 
 Bezigon با کليک و درگ کردن مي‌توان منحني رسم كرد اما هنگام رسم منحني با ابزار Pen

بايد کليد Alt را پايين نگه داريد و بعد کليک کنيد؛ پس از ترس��يم، هر گره‌اي را که نياز به 
انحنا دارد، انتخاب کرده و تغيير دهيد )شکل 5-11(.

Bezigon رسم منحني با ابزار                       Pen رسم منحني با ابزار

شکل 5-11

Bezigon 1-2-5 ترسيم مسير صاف با استفاده از ابزار
1- ب��ا اس��تفاده از ماوس روي ابزار Pen واقع در جعبه اب��زار Tools کليک کرده و از منوي 

ظاهر شده گزينه Bezigon tool را انتخاب کنيد.                                 

Bezigon شکل 12-5  ابزار 

2- با ماوس روي قس��متي از صفحه که مي‌خواهيد نقطه شروع خط باشد، کليک کنيد؛ 
در اين حالت يک مستطيل توخالي نمايان مي‌شود.

3- با اس��تفاده از ماوس در قسمتي از صفحه که مي‌خواهيد نقطه دوم خط باشد، کليک 
کنيد.

Bezigon 2-2-5 ترسيم مسير منحني با استفاده از ابزار
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4- روي اب��زار Pen واق��ع در جعبه اب��زار  Toolsکليک کرده و ازمنوي‌ظاهر ش��ده گزينه
 Bezigon tool را انتخاب کنيد. 

5- با ماوس روي قس��متي از صفحه که مي‌خواهيد نقطه شروع خط باشد، کليک کنيد؛ 
در اين حالت يک مستطيل توخالي نمايان مي‌شود.

6- کليد Alt را پايين نگه داش��ته و با ماوس در قس��متي از صفحه که مي‌خواهيد نقطه 
دوم خط باشد، کليک کنيد.

7- همان‌طورکه در ش��کل 13-5 مشاهده مي‌کنيد، س��ه گره b ،a و c روي مسير ايجاد 
شده‌اند حال مي‌توانيد به وسيله ماوس هر يک از اين گره‌ها را انتخاب کرده و درگ کنيد تا 

منحني موردنظر ايجاد شود )شکل 5-14(.

   
        شکل 13-5 رسم منحني با ابزار Bezigon          شکل 14-5 تغيير گره b و ايجاد منحني

• مي‌توانيد با کليک روي يک گره  	Pen پس از ايجاد يک مسير با اين ابزار، همانند ابزار
واقع در مسير، آن گره را حذف کنيد و با يک بار کليک روي قسمتي از مسير، در آن 

قسمت يک گره ايجاد کرده، سپس مسير موردنظر را ويرايش کنيد.
Bezigon 3-2-5 تنظيمات ابزار

با دابل کليک روي ابزار  Bezigon کادرمحاوره Bezigon Tool )ش��کل 15-5( باز مي‌شود. 
انتخاب گزينه Auto constrain باعث مي‌ش��ود تا هنگام ترسيم با ابزار Bezigon، شئ به طور 
خودكار محدود ش��ود. به عبارت ديگر خطوط در زواياي 0، 45 و90 درجه به صورت راس��ت 
ترسيم مي‌شوند و مانند اين است كه كليد ‌‌Shift را هنگام ترسيم نگه ‌داشته‌ايد. در اين زوايا 
دايره كوچكي كنار اش��اره‌گر ظاهر مي‌ش��ود كه نشان مي‌دهد شئ محدود )constrain( شده 

است.

Bezigon Tool شکل 15-5 کادرمحاوره

 مثال 3: شکل 16-5 را با ابزار Bezigon رسم کنيد.
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شکل 5-16 

1- ابتدا ابزار Bezigon را از جعبه ابزار برگزينيد.
2- قسمت بدنه فلفل را رسم کنيد. به ميزان انحناي مسير براي رسم بدنه توجه کنيد و 

هنگام ترسيم، براي ايجاد اين انحنا ماوس را به اندازه لازم درگ کنيد.         
3- قسمت سر فلفل را رسم کنيد.

 تمرين 2: شکل 17-5 را با ابزار Bezigon و Pen رسم کنيد.    

شکل 5-17

3-5 ابزار ترسيم خط )Line( و تنظيمات آن 
براي رس��م خطوط مايل و مس��تقيم و ايجاد اشکال دلخواه يا متصل کردن چند شکل به 

يکديگر از ابزار Line استفاده مي‌شود.
1-3-5 ترسيم خط

1- ابزار Line را از جعبه ابزار Tools انتخاب کنيد.
2- اشاره‌گر ماوس را در نقطه‌اي از صفحه قرار دهيد.

3- ماوس را در جهت و زاويه موردنظر به اندازه دلخواه درگ کنيد.
4- به محض اين که کليد ماوس را رها کنيد، ترسيم خط تمام مي‌شود.

 توج�ه: براي رس��م خط با زاويه° 45 )خط مايل( يا °90 يا خط راس��ت )افقي و 
عمودي( هنگام استفاده از ابزار Line کليد Shift را پايين نگه داريد.
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اگر هنگام‌رس��م‌خط کليدهاي Shift و Alt را همزمان پايين نگه داريد، خط به صورت 
صاف و از مرکز رسم مي‌شود.

2-3-5 مشاهده خواص خط در هنگام رسم
با اس��تفاده از نوارابزار Info واقع در من��وي Windows→Toolbars→Info مي‌توانيد هنگام 
رس��م خط، قبل از رها ک��ردن کليد ماوس در نقطه انتهايي، مختص��ات، طول و زاويه خط را 

مشاهده کنيد.

                      

Info شکل 18-5  نوار

Line 3-3-5 تنظيمات ابزار
 با دابل کليک روي ابزار Line کادرمحاوره Line Tool )شکل 19-5( باز مي‌شود. انتخاب گزينه
Auto constrain باع��ث مي‌ش��ود تا هنگام ترس��يم با ابزار Line در زواي��اي 45، 0 و90 درجه 

                      		 خطوط به اين زوايا محدود شده و به صورت راست رسم شوند.

Line Tool شکل 19-5 کادر

 مثال 4: شکل 20-5 را با ابزار Line رسم کنيد.
1- ابتدا از محل مشخص شده در شکل شروع کنيد )محل شروع دلخواه است(.

2- ابزار  Lineرا از جعبه ابزار برگزينيد.                                                     

شکل 5-20
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 3- اشاره‌گر ماوس را در نقطه‌اي از صفحه قرار داده و به طور مورب به سمت بالا درگ کنيد
)زاويه در حدود 35°(، قبل از رها کردن کليد ماوس در نقطه انتهايي، طول و زاويه خط را از 

نوار ابزار Info مشاهده کنيد. 
4- اکنون اشاره‌گر ماوس را روي نقطه پاياني خط اول قرار داده و به طور مورب به سمت 

پايين درگ کنيد، توجه کنيد که طول و زاويه خط به اندازه خط اول باشد. 
5- خطوط بعدي را هم با روش ذکر شده، رسم کنيد.

تمرين 3: شکل‌هاي بعد را با کمک ابزار Line رسم کنيد.
 

شکل 5-21  

4-5 ابزار Pencil و تنظيمات آن 
اين ابزار امکان ترس��يم ش��کل‌هاي به صورت آزاد را به شما مي‌دهد به طوري که به نظر 
مي‌رسد يک مداد واقعي را در دست داريد و مي‌توانيد اشکال مورد نظر خود را رسم كنيد. 

  Pencil 1-4-5 ترسيم مسير با استفاده از ابزار
1- از جعبه ابزار Tools ابزار Pencil را برگزينيد.

2- با ماوس روي قسمتي از صفحه که مي‌خواهيد نقطه شروع خط باشد، کليک کنيد و 
بدون رها کردن كليد سمت چپ ماوس عمل درگ را انجام دهيد. 

3- براي رسم خطوط راست در حين ترسيم با ماوس، کليد Alt را پايين نگه داريد و براي 
ادامه مسير كليد Alt را رها كنيد ولي كليد ماوس را رها نكنيد.

Pencil شکل 22-5 رسم مسير با ابزار
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4- وقتي رسم مسير پايان يافت، كليد سمت چپ ماوس را رها کنيد.
ب��ه منظ��ور انجام تنظيمات ابزار Pencil، در جعبه اب��زار Tools روي اين ابزار دابل کليک 

كنيد. کادر محاوره Pencil Tool مطابق شکل 23-5 ظاهر مي‌شود.
• را  در قس��مت Precision مي‌توانيد با حرکت دادن دکمه لغزنده عددي بين 1 تا 10	
تعيين كنيد. انتخاب اعداد بزرگ‌تر باعث مي‌شود تا هنگام ترسيم، روي مسير رسم 
ش��ده گره‌هاي بيش��تري وجود داشته باشد و بتوانيد با اس��تفاده از اين گره‌ها شکل 
را ويرايش نماييد. با اس��تفاده از اين گزينه مي‌توانيد ميزان دقت کار خود و تبعيت 

مسير از حرکت مکان‌نما را تعيين كنيد.

Pencil Tool شکل 23-5 کادرمحاوره

• باعث مي‌ش��ود در پيش‌نمايش رس��م، خطوط به  	Draw dotted line انتخ��اب گزينه
صورت نقطه‌چين نمايان ش��وند و مس��يرها س��ريع‌تر ترسيم ش��وند اما بعد از رسم، 

خطوط به صورت رنگ توپر نمايش داده مي‌شوند.

مثال 5: شکل 24-5 را با ابزار Pencil رسم کنيد.
 

ابزار Pencil را انتخاب کرده ش��کل مورد نظر را رس��م نماييد. براي رسم خطوط صاف از 
کليد Alt استفاده كنيد.

براي ادامه دادن مس��ير، ابزار Pencil را روي نقطه پاياني مسير قرار دهيد؛ علامت بعلاوه 
)+( نمايان مي‌شود. در همان نقطه کليک کرده و مسير را ادامه دهيد.	

شکل 5-24
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5-5 ابزار Variable Stroke Pen tool و تنظيمات آن 
براي ترسيم خطوط با ضخامت‌هاي متغير مي‌توانيد از اين ابزار استفاده كنيد.

Variable Stroke Pen tool 1-5-5 ترسيم مسير با استفاده از ابزار
 Variable Stroke Pen tool کليک کرده و از منوي ظاهر ش��ده ابزار Pencil 1- روي اب��زار

را انتخاب نماييد.

Variable Stroke Pen tool شکل 25-5  ابزار

2- مکان‌نم��اي م��اوس را در محل مورد نظر روي صفحه ق��رار داده و همان‌طورکه کليد 
ماوس را نگه داشته‌ايد مسير مورد نظر را با درگ کردن رسم نماييد.

3- به منظور اعمال تنظيمات روي اين ابزار در جعبه ابزار دابل کليک كنيد. در اين‌صورت 
کادر محاوره  Variable Stroke Pen مطابق شکل 26-5 نمايان مي‌شود.

Variable Stroke Pen شکل 26-5 کادرمحاوره

• گزينه Precision: اين گزينه به شما امکان بالا بردن دقت کار را مي‌دهد.	
• با انتخاب اين گزينه به صورت اتوماتيک قسمت‌هايي  	:Auto remove overlap گزينه

از شکل که روي هم قرار دارند، حذف مي‌شوند.
اين قسمت داراي دو گزينه است که به شما امکان تنظيم پهنا براي  • 	 :Width قسمت

نازک‌ترين و ضخيم‌ترين قسمت خط از 1 تا 72 را مي‌دهد.

Auto remove overlap شکل 27-5 نتيجه حاصل از فعال و غيرفعال بودن گزينه
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 توجه: هنگام رس��م مس��ير با اب��زار Variable Stroke Pen tool مي‌توانيد توس��ط 
کليدهاي جهت‌دار صفحه کليد، ضخامت مسير را تغيير دهيد.

6-5 ابزار خوشنويسي Calligraphic Pen tool و تنظيمات آن
با استفاده از اين ابزار مي‌توانيد خطوط هنري ايجاد كنيد.

Calligraphic Pen tool 1-6-5 ترسيم خطوط هنري با استفاده از ابزار
1- روي اب��زار Pencil کليک کرده و از منوي ظاهر ش��ده اب��زار Calligraphic Pen tool را 

انتخاب نماييد. 

 Calligraphic Penشکل 28-5  ابزار

2- مکان‌نم��اي ماوس را در محل مورد نظ��ر روي صفحه قرار داده و همان‌طور که کليد 
ماوس را نگه داشته‌ايد مسير مورد نظر را با درگ کردن رسم نماييد.

Calligraphic Pen toolشکل 29-5 ايجادخطوط‌هنري به‌وسيله ‌ابزار

3- به منظور اعمال تنظيمات روي اين ابزار در جعبه ابزار دابل کليک كنيد. در اين‌صورت 
کادر محاوره Calligraphic Pen مطابق شکل 30-5 نمايان مي‌شود.

بعضي از گزينه‌هاي اين کادر محاوره‌ قبلًا توضيح داده شده است، در ادامه به توضيح ساير گزينه‌ها 
مي‌پردازيم:

• يا  	(Fixed) توسط گزينه‌هاي اين قسمت مي‌توانيد يک ضخامت ثابت :Width قسمت
متغير (Variable) را براي نوک قلم تعيين كنيد.

• در اين قس��مت مي‌توان زاويه قلم را به صورت عددي يا به‌‌وس��يله  	:Angle قس�مت
دايره کناري کنترل كرد.
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 Calligraphic Pen شکل 30-5 کادرمحاوره

 Variable Strokeو Pencil ،Calligraphic Pen tool  تمرين 4: شکل 31-5 را با ابزار

Pen tool رسم کنيد. 

شکل 5-31

  (Rectangle) 7-5 ابزار ترسيم چهارگوش
از اي��ن ابزار براي ترس��يم مس��تطيل، مربع و به طورکلي اش��کال چهارگوش اس��تفاده 

مي‌کنيم.          
1-7-5 ترسيم مستطيل 

1- روي ابزار Rectangle واقع در جعبه ابزار Tools کليک کنيد.                                      
2- اشاره‌گر ماوس را )که با علامت + نمايش داده مي‌شود( روي صفحه قرار داده و كليد 
ماوس را نگه داشته و به سمت چپ يا راست درگ کنيد. در اين حالت مربع‌هاي کوچکي در 

اطراف چهارضلعي ظاهر مي‌شود که به آن‌ها مربع‌هاي انتخاب مي‌گويند. 
پس‌از انتخاب شك��ل توس��ط اب��زار Pointer، اش��اره‌گر را درامتداد‌خط‌قط��ري )مورب( 

بين‌دوگوشه درگ کنيد.
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شکل 32-5 جهت حرکت اشاره‌گر براي رسم مستطيل

 توجه: براي رسم مستطيل از نقطه وسط )مرکز( کليد Alt را نگه داريد.      
در صورت لزوم مي‌توانيد بعد از رسم مستطيل، ابعاد آن را از طريق پنل Object واقع در 

منوي Window تغيير دهيد.

2-7-5 ترسيم مربع

1- براي رسم مربع مانند مراحل قبل عمل کنيد.
2- در هنگام درگ ماوس کليد Shift را پايين نگه داريد.

 توجه: براي رس��م مربع از نقطه وس��ط )مرکز( کليده��اي Shift و Alt را همزمان 
فشار دهيد.

مي‌توان با ابزار Rectangle چهارضلعي‌هايي با گوش��ه‌هاي منحني )گرد( رسم کرد. ميزان 
انحناي گوشه‌ها به گزينه Corner radius )شعاع گوشه‌ها( بستگي دارد )شکل 5-33(.

تنظيمات Corner radius باعث انحنا يا تيزي گوشه‌هاي چهارگوش مي‌شود.

شکل 33- 5

تنظيم شعاع‌هاي گوشه‌اي چهارضلعي
 Rectangle دابل کليک کنيد تا کادرمحاوره Rectangle روي ابزار Tools 1- در جعبه ابزار
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 Tool باز شود.

به طور پيش‌فرض شعاع انحناي گوشه‌ها صفر است. هر چه اين عدد بزرگ‌تر باشد، ميزان 
انحناي گوشه‌هاي چهارضلعي بيشتر خواهد شد. 

2- در کادرمحاوره ظاهر ش��ده مي‌توانيد مقدار مورد نظر جهت شعاع گوشه را در مقابل 
گزينه  Corner radius   تايپ کرده يا از دکمه لغزنده استفاده کنيد.

3- روي دکمه OK کليک کرده و شکل را رسم کنيد.

Rectangle Tool شکل 34-5 کادر محاوره

 نكته: واحد انحناي گوشه‌ها بر اساس واحد صفحه است.

تغيير ابعاد مستطيل
1-مستطيل مورد نظر را انتخاب کنيد.

2- به پنل Object برويد و مراحل بعد را انجام دهيد.
3- با استفاده از گزينه Corners مي‌توان مقدار انحناي گوشه‌ها را تغيير داد.

4- براي اعمال تغييرات کليد Enter را فشار دهيد.

 توجه: براي ايجاد تنظيمات مختلف براي هر گوشه مستطيل، گزينه Uniform را 
غيرفعال كنيد و در هر فيلد مقدار شعاع گوشه را وارد كنيد.
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Object شکل 35-5  پنل

 مثال 6: شکل 36-5 را با ابزار Rectangle رسم کنيد.  

Rectangleشکل 36- 5 ترسيم شکل با ابزار

1- ابتدا يک مستطيل بزرگ رسم کنيد.
2- در بالاي اين مستطيل يک مستطيل ديگر رسم کنيد.

3- براي پنجره‌هاي اين خانه دو مربع هم اندازه و هم مرکز رسم کنيد.
4- يک مس��تطيل براي در خانه رس��م کرده و داخل آن يک مس��تطيل کوچک‌تر قرار 

دهيد. 

تمرين 5: شکل‌هاي زير را توسط ابزار مستطيل ايجاد کنيد.

شکل 37-5 مربع‌هاي هم‌مرکز، آدم آهني و نردبان                
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 Ellipse 8-5 ابزار ترسيم
از اين ابزار براي رسم بيضي يا دايره استفاده مي‌کنيم.

1-8-5 ترسيم بيضي يا دايره

1- در جعبه ابزار  Tools روي ابزار Ellipse کليک کنيد.
2- اش��اره‌گر ماوس را روي مح��ل موردنظر از صفحه قرار داده و به س��مت مقابل درگ 

کنيد.

 توجه: با نگه داش��تن کليد Shift مي‌توان از ابزار Ellipse براي رسم دايره استفاده 
کرد.

هنگام استفاده از ابزار Ellipse اگر کليد Alt را پايين نگه داريد، بيضي از مرکز رسم مي‌شود.

براي رسم دايره از مرکز هنگام استفاده از ابزار Ellipse کليدهاي Alt وShift را پايين نگه‌داريد.

با استفاده از پنل Object مي‌توان ابعاد بيضي رسم شده را تغيير داد.
تمرين 6: ش��کل‌هاي بعدي را توس��ط ابزارهايي که تاکنون آموخته‌ايد، رس��م 

کنيد. 

شکل 5-38

(Polygon) 9-5 ابزار ترسيم چندضلعي
از اين ابزار براي ترس��يم چندضلعي و س��تاره استفاده مي‌ش��ود. ابزار ترسيم چندضلعي 

همراه با ابزار ترسيم مستطيل در يک گروه قرار دارند.
1-9-5 ترسيم يک چند‌ضلعي

1- روي ابزار Rectangle واقع در جعبه ابزار Tools کليک کرده و از منوي ظاهر شده ابزار 
Polygon tool را انتخاب کنيد.
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Polygon tool شکل 39-5 ابزار

2- ح��ال روي اب��زار Polygon واقع در نوار ابزار Tools دابل کلي��ک کنيد تا کادرمحاوره
 Polygon Tool باز شود.

3- در اين کادرمحاوره، گزينه Number of Sides مشخص کننده تعداد اضلاع چند ضلعي 
اس��ت. تعداد اضلاع چند ضلعي بيشتر مي‌ش��ود تا به عدد 20 برسد که در اين صورت شکل 

حاصله دايره خواهد بود.       

         

Polygon Tool شکل 40-5 کادرمحاوره

Shape -4 مش��خص کننده نوع چند ضلعي است که امکان انتخاب شکل را از بين ستاره 

)Star( يا چند ضلعي )Polygon( مي‌دهد )در اينجا Polygon انتخاب مي‌شود).
5- روي دکمه OK کليک کنيد.

6- اش��اره‌گر م��اوس را روي قس��متي از صفحه که مي‌خواهيد مرک��ز چند ضلعي در آن 
قسمت قرار گيرد، بگذاريد و به سمت خارج درگ کنيد.

7- با چرخش ماوس مي‌توانيد چندضلعي را نيز بچرخانيد.
تمرين 7: شکل 41-5 را رسم کنيد.

 

شکل 5-41
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10-5 ابزار ترسيم ستاره  
از ابزار Polygon براي ترسيم ستاره استفاده مي شود.

ترسيم ستاره
1- در جعبه ابزار Tools روي Polygon دابل کليک کنيد تا کادرمحاوره Polygon Tool باز 

شود.
2- در قسمت Shape گزينه Star را برگزينيد.

3- در قسمت Number of Sides تعداد اضلاع ستاره را وارد کنيد.
4- با فعال کردن گزينه Automatic ستاره اي رسم مي شود که زاويه بين اضلاع آن به طور 

اتوماتيک تنظيم شده است.
5- با فعال کردن گزينه Manual مي توانيد زاويه بين اضلاع ستاره را به صورت دستي به 

کمک دکمه لغزنده واقع در قسمت  Star Pointsتنظيم کنيد.

شکل 42-5 کادر محاوره Polygon Tool براي رسم ستاره

 نکته: انتخاب گزينه Star به شما امکان رسم يک شکل سه وجهي )شبيه مثلث 
متساوي الاضلاع( تا يک شکل 20 وجهي يعني شکلي مشابه دايره را مي دهد.

ــکال 43-5 را رسم کنيد، براي رسم ستاره مشخص شده مراحل بعد  مثال 7: اش
را انجام دهيد: 

1- روي گزينه Polygon از نوار ابزار دابل کليک کنيد.
2- در کادرمحاوره Polygon Tool گزينه Star را برگزينيد.

ــکل 6 است، وارد  ــتاره را که در اين ش ــمت Number of Sides تعداد اضلاع س 3- در قس
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کنيد.

شکل 5-43 

4- با فعال کردن گزينه Manual، دکمه لغزنده واقع در قس��مت Star Points را به س��مت
acute ببريد تا زاويه بين اضلاع ستاره مطابق شکل شود. 

5- بقيه ستاره‌ها مشابه روش ذکر شده، رسم مي‌شوند.
تمرين 8: شکل 44-5 را با استفاده از ابزارهايي که آموخته‌ايد، رسم کنيد.

شکل 5-44

مثال كاربردي: در اين‌ مثال مي‌خواهيم بخش��ي از آرم مثال كاربردي را رس��م 
 

کنيم، براي اين منظور مراحل زير را انجام دهيد:

شكل 5-45

1- فايل Project مثال کاربردي واحد کار 4 را باز کنيد. 
 w يك چهارگوش با ابعاد Pen 2- در صفحه‌اي که قبلًا ايجاد کرديد؛ با اس��تفاده از ابزار
برابر 7 و h برابر 26/5 رس��م كنيد، س��پس كليد Enter را بفشاريد. چهارگوش مطابق شكل 

46-5 به يك مستطيل 26/5×7 عمودي تبديل مي‌شود.
3- اکنون مي‌خواهيم گوش��ه س��مت راس��ت پايين مس��تطيل را گرد كنيم. از آن‌جا كه 
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ترس��يم يك كمان نياز به س��ه نقطه لنگر دارد با توجه به دو نقطه لنگر پايين مستطيل؛ يك 
نقطه لنگر روي مستطيل ايجاد ك‌نيد. براي اين كار به‌وسيله ابزار Pen در نقطه تعيين شده در 

شكل 47-5 روي ضلع سمت راست مستطيل كليك كنيد تا يك نقطه به آن اضافه شود.
4- تغييرات را ذخيره کنيد.

               

 شكل 46-5                                     شکل 5-47

واژه‌نامه
Angleزاويه

Bezigonبزيه

Calligraphicخوشنويسي

Ellipseبيضي

Overlapهمپوشاني

Precisionدقت

Shapeشکل

Strokeخط

Variableمتغير

خلاصه مطالب
• براي ترسيم اشکال در FreeHand MXa از جعبه ابزار Tools استفاده مي‌شود.	
• ابزار Bezigon براي رسم خط صاف يا منحني مورد استفاده قرار مي‌گيرد.	
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 • 	Line هر دو براي رس��م خط به‌کار مي‌رود، با اين تفاوت که با Bezigon و Line ابزار
فقط مي‌توان پاره‌خط رسم کرد اما نمي‌توان خطوط را به هم متصل کرد.

 • 	Variable Stroke Pen براي ترس��يم خطوط با ضخامت‌هاي متغير مي‌تواني��د از ابزار
tool استفاده كنيد.

• با استفاده از ابزار Calligraphic Pen tool مي‌توانيد خطوط هنري ايجاد كنيد.	
• به منظور ترسيم اشکال چهارگوش استفاده مي‌شود.           	Rectangle از ابزار

• از ابزار Ellipse براي رسم بيضي يا دايره استفاده مي‌شود.	
• از ابزار Polygon براي ترسيم چندضلعي و ستاره استفاده مي‌شود.	
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آزمون نظري
درستي يا نادرستي گزينه هاي زير را تعيين کنيد.

1- براي ترسيم اشکال در FreeHand MXa از جعبه ابزار Tools استفاده مي‌شود.
2- با استفاده از ابزار Variable Stroke Pen tool مي‌توانيد خطوط هنري ايجاد نماييد.

3- از ابزار Polygon براي ترسيم چندضلعي و ستاره استفاده مي‌شود.
4- از ابزار Rectangle براي رسم بيضي يا دايره استفاده مي‌شود.

معادل گزينه هاي سمت ‌راست را از ستون سمت ‌چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

      Line                   .1- از اين ابزار به منظور ترسيم اشکال چهارگوش استفاده مي‌شود
Pen                     .2- اين گزينه به شما امکان رسم يک شکل سه وجهي را مي‌دهد
Rectangle             .3- براي رسم خطوط مايل و مستقيم از اين ابزار استفاده مي‌شود

                  Star                     .4- براي رسم خطوط صاف و منحني از اين ابزار استفاده مي‌شود
گزينه صحيح را انتخاب کنيد.

5- در چه مواقعي از ابزار Ellipse در جعبه ابزار استفاده مي‌کنيد؟
ب- رسم دايره و بيضي الف- رسم چندضلعي          	

		            د- رسم چهارگوش ج- رسم کمان
6- براي اين‌که اش��کال گرافيکي هنگام ترس��يم از مرکز به اطراف گسترش يابند از کدام 

کليد استفاده  مي‌کنيد؟
                          Alt -د                Shift -ج               Ctrl  -ب            Tab -الف

7- براي رسم ستاره (Star) از کدام ابزار استفاده مي‌کنيد؟
 Ellipse -ب 		        Rectangle -الف
 Bezigon -د 		      Polygon -ج

8- در کادرمحاوره Polygon گزينه Number of Sides چه کاربردي دارد؟
الف- زاويه بين اضلاع چند‌ضلعي را مشخص مي‌کند.

ب- تعداد اضلاع چندضلعي را مشخص مي‌کند.
ج- مشخص‌ کننده نوع چندضلعي است.

د- باعث رسم شکل با لبه‌هاي هموار مي‌شود.
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9- کدام‌‌يک از ابزارهاي زير، فقط امکان رسم خطوط مستقل از هم را فراهم مي‌آورد؟
Rectangle -د               Bezigon -ج               Pen -ب              Line  -الف 

10- براي ترس��يم خط صاف و ° 45 به هنگام استفاده از ابزار Line از کدام کليد مي‌توان 
استفاده کرد؟

Alt -د               Shift  -ج                Ctrl -ب               Space -الف
11- کدام گزينه صحيح است؟

الف- هنگام اس��تفاده از ابزار Bezigon براي رس��م منحني بايد کلي��د Shift را پايين نگه 
داريد.

ب- با استفاده از ابزار Rectangle مي‌توان اشکالي به شکل ستاره رسم کرد.
ج- درص��ورت فعال بودن ابزار  Penهنگامي ک��ه روي صفحه، کليک مي‌کنيم يک نقطه 

گوشه به‌وجود مي‌آيد.
د- با ابزار Line مي‌توان خطوط منحني رسم کرد.

در جاي خالي عبارت مناسب را بنويسيد.

12- انتخاب  گزينه  Precision در کادرمحاوره Variable Stroke Pen tool به شما ................ 
را مي‌دهد.

13- با نگه داش��تن کلي��د ......... مي‌تواني��د خطوطي با زاويه 45 درجه ي��ا عمود ايجاد 
کنيد.

14- براي رسم مستطيل از نقطه وسط )مرکز( کليد ........ را نگه داريد.
15- ابزار Bezigon براي ........................... مورد استفاده قرار مي‌گيرد.

به سؤالات زير پاسخ تشريحی دهيد.

16- تفاوت ابزار Pen با ابزار Bezigon چيست؟
17- چگونه مي‌توان مربعي با گوشه‌هاي گرد رسم کرد؟

18- چند نوع نقطه روي يک مسير موجود است، نام ببريد.
19- تفاوت ابزار Line با ابزار  Pen چيست؟
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آزمون عملي  
1- شکل‌هاي زير را رسم کنيد.

2- شکل‌هاي زير را با ابزارهاي خطوط هنري ترسيم كنيد.
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كليات
با اس��تفاده از ابزارهاي ترسيمي در FreeHand MXa مي‌توان اشکال و تصاوير مختلفي را 
ايجاد کرد. در واحد كار 5 با تعدادي از ابزارها براي طراحي و ترسيم مسيرها آشنا شديد؛ در 

اين واحد كار به معرفي ابزارهاي ترسيمي ديگر خواهيم پرداخت.   
  Arc1-6 ابزار

براي ترسيم کمان )باز، بسته، محدب و مقعر( يا منحني از اين ابزار استفاده مي‌شود.
Arc 1-1-6 روش کار با ابزار

1- روي ابزار Line، كليد س��مت چپ ماوس را نگه داريد تا كادري مطابق شكل 1-6 باز 
شود، سپس ابزار Arc را انتخاب كنيد.

Arc tool شکل 1-6 انتخاب ابزار

2- در قس��مت دلخواه��ي از صفحه، کليک کرده و عم��ل درگ را انجام دهيد. مي‌توانيد 
نحوه ترس��يم کمان را تغيير دهيد و کمان را به صورت باز، محدب يا مقعر رس��م كنيد. براي 

اين منظور ابتدا بايد ابزار Arc را تنظيم كنيد.
Arc 2-1-6 تنظيمات ابزار

1- روي ابزار  Arcدابل کليک کنيد تا کادر محاوره Arc مطابق شکل 2-6 باز شود.

Arc شکل 2-6 کادر محاوره

نتيجه انتخاب  هر يك از گزينه‌هاي كادرمحاوره Arc در ش��کل 3-6 نش��ان داده ش��ده 
است.

2- روي دکمه OK کليک کنيد.
3- حال در نقطه‌اي دلخواه از صفحه، کمان را رسم کنيد.
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شکل 3-6 رسم سه نوع کمان

 مثال 1: يک کمان بسته محدب رسم کنيد.
1- روي ابزار  Arcدابل کليک کنيد تا کادرمحاوره Arc باز شود.

2- از کادرمحاوره باز شده، گزينه Create flipped arc را انتخاب کنيد تا کمان به صورت 
بسته با قوس محدب ترسيم شود.

3- روي دکمه OK کليک کنيد.
4- در نقطه دلخواهي از صفحه، کمان را رسم کنيد.

 نكته: براي تغيير جهت کمان در راس��تاي افقي و عمودي، پس از ترس��يم، کليد 
 Shift را نگه داريد. براي ترس��يم کمان به صورت قوس بس��ته يک چهارم دايره از کليد Alt

استفاده كنيد.

تمرين 1: کاربرد کليد Ctrl را در حين ترسيم هر يک از کمان‌ها بررسي کنيد.
 Spiral 2-6 ابزار

براي ترسيم خطوط مارپيچ از اين ابزار استفاده مي‌شود.
Spiral 1-2-6 روش کار با ابزار

1- از منوي بازشوي Line در جعبه ابزار روي ابزار  Spiral کليک كنيد.
2- روي قس��مت دلخواهي از صفحه کليک ک��رده و عمل درگ را انجام دهيد. مي‌توانيد 

نحوه ترسيم مارپيچ را تغيير دهيد.
Spiral 2-2-6 تنظيمات ابزار

1- روي اب��زار Spiral دابل‌کلي��ک کنيد ت��ا کادرمحاوره Spiral مطابق ش��کل 4-6 ظاهر 
شود.
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در اين کادر محاوره گزينه‌هايي وجود دارد که روي مارپيچ و نوع آن اثر مي‌گذارند.
2- گزينه Spiral type  نوع مارپيچ را تعيين مي‌کند )شکل 6-5(.

                   	                

شکل 5-6 انواع مارپيچ 	Spiral شکل 4-6 کادرمحاوره                 

ب��ا انتخاب مارپيچ گسترش��ي )Expanding(، مارپيچ به صورت گس��ترش يافته ترس��يم 
مي‌شود يعني فاصله ميان حلقه‌ها از مرکز به سمت خارج به تدريج افزايش مي‌يابد.

در مارپيچ غيرگسترش��ي )Non-expanding( که به آن مارپيچ ساده هم مي‌گويند فاصله 
ميان حلقه‌ها يکسان است.

گزينه‌هاي بعدي با توجه به نوع مارپيچ تغيير مي‌کنند.
Expansion: اي��ن گزينه وقتي ظاهر مي‌ش��ود که مارپيچ از نوع گس��ترش يافته انتخاب 

ش��ده باشد. در اين قسمت به وس��يله حرکت دادن دکمه لغزنده يا وارد کردن عدد در کادر 
مقابل Expansion، مقدار فاصله بين حلقه‌هاي مارپيچ برحسب درصد تعيين مي‌شود )شکل 

 .)6-6

 

Expansion شکل 6-6 مقايسه مقادير وارد شده در کادر

Draw by: اين كادر بازشو داراي دو حالت انتخابي است: 

 • 	Number of با انتخاب اين حالت در هر دو ن��وع مارپيچ، گزينه : Rotationsحال�ت
rotations ظاهر مي‌ش��ود که با اس��تفاده از دکمه لغزنده يا وارد کردن عدد در کادر 

مربوطه مي‌توان تعداد حلقه‌هاي مارپيچ يا تعداد چرخش‌هاي آن را تعيين کرد.
غيرگسترشي، فاصله بين حلقه‌ها  • حالت Increments: با انتخاب اين گزينه در مارپيچ 	
در کادر Increment Width  وارد مي‌ش��ود که س��بب رسم مارپيچ با  فواصل يکسان 
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 Starting( در چرخش‌ها خواهدشد. درمارپيچ‌گسترشي، شعاع‌آغازين براي‌رسم‌مارپيچ
radius( تعيين مي‌شود.  

• Draw from: اين كادر بازشو چگونگي آغاز ترسيم مارپيچ را مشخص مي‌کند که در 	

آن ســه حالت انتخاب وجود دارد که در صورت انتخاب حالت Center نقطه شــروع 
مارپيچ از مرکز خواهد بود و با انتخاب حالت Edge نقطه شــروع مارپيچ از لبه و در 

حالت Corner نقطه شروع مارپيچ از گوشه خواهد بود )شکل 6-7(.
      پيکان‌هاي رسم شده در مارپيچ، نقطه شروع و جهت رسم آن‌ها را نشان مي‌دهند.

  Draw fromشکل 7-6 مقايسه سه حالت انتخابي در منوي بازشو

• Direction: با انتخاب آيکن  مارپيچ در خلاف جهت عقربه‌هاي ساعت و با فعال 	

کردن آيکن  مارپيچ در جهت عقربه‌هاي ساعت ترسيم مي‌شود.
روي دکمه OK کليک کنيد.

مثال 2: شــکل 1-8-6 را رسم کنيد ســپس آن‌را در طراحي‌حاشيه ترسيم‌شده 
درشكل 2-8-6 به كار بريد.      

                   
شکل 1-8-6                                    شکل 6-8-2

1- روي ابزار Spiral دابل کليک کنيد تا کادرمحاوره Spiral ظاهر شود.
2- نوع مارپيچ را غيرگسترشي )ساده( انتخاب کنيد.

3- در منوي بازشوDraw by  نوع ترسيم مارپيچ را Rotations )پيچشي( انتخاب کنيد.
4- در کادرNumber of rotations  تعداد چرخش‌هاي مارپيچ را 4 قرار دهيد.

5- در قسمت Direction آيکن  را انتخاب کنيد تا مارپيچ در خلاف جهت عقربه‌هاي 
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ساعت ترسيم شود.
6- روي OK کليک کنيد.

7- شکل را روي صفحه رسم کنيد.
 )Pointer( 3-6 ابزار انتخاب

 FreeHandواقع در جعبه ابزار )شکل 12-6(، يکي از کاربردي‌ترين ابزارها در Pointer ابزار
MXa است و در موارد زير از آن استفاده مي‌شود:

 نكته: اگر ابزار ديگري از ToolBox انتخاب شده‌باش��د، فش��ردنك‌ليد Ctrl سبب‌ 
انتخاب‌ ابزار Pointer  مي‌شود.

1-3-6 انتخاب، جابه‌جايي و حرکت دادن موضوعات گرافيکي 

1- ب��ه کمک اب��زار Pointer روي موضوع مورد نظر کليک کنيد؛ در اين حالت نقاطي در 
کناره‌هاي شکل ظاهر مي‌شود و موضوع مطابق شکل 9-6 به حالت انتخاب درمي‌آيد.

2- با كمك ماوس به ‌آرامي درگ کنيد، در ‌اين ‌حالت اشاره‌گر ‌ماوس به ‌شکل يک‌ پيکان 
(. حال مي‌توانيد مانند ش��کل 10-6 پيش‌نمايشي از  ‌چهار‌طرفه نمايش داده مي‌ش��ود )

حرکت موضوع انتخاب شده را ببينيد.
3- كليد ماوس را در محل دلخواه رها کنيد. شکل به محل موردنظر انتقال مي‌يابد. 

                                     
شکل 9-6 انتخاب شکل با ابزار Pointer        شکل 10-6 پيش‌نمايشي از حرکت شکل انتخاب شده

 نكته: براي تنظيم پيش‌نمايش حركت موضوعات هنگام درگ آن‌ها، بايد در كادر 
متن��ي Preview drag در كادر محاوره Preferences در زبان��ه Redraw مقداري را وارد كنيد. 
توجه داشته باشيد وارد كردن عدد بزرگ سبب آهسته شدن پيش‌نمايش حركت موضوعات 

خواهد شد.
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مثال 3: شکل 16-6 را رسم کنيد و سپس آن را به محل ديگري منتقل كنيد.
 

1- شکل را با استفاده از ابزار Pen  رسم کنيد. 
2- حال شکل را با ابزار Pointer انتخاب کنيد.

براي اين کار ابتدا ابزار Pointer را از جعبه ابزار انتخاب کرده، س��پس روي ش��کل 6-16 
کليک کنيد.                                                               

 شکل 11-6 ترسيم شکل   

3- حال شکل انتخاب شده را تغيير مکان دهيد.
ب��راي اين منظور با كمك ماوس به آرامي درگ کنيد )در اين حالت اش��اره‌گر ماوس به 
ش��کل يک پيکان چهار طرفه نمايش داده مي‌ش��ود( و در محل مورد نظر کليد ماوس را رها 

کنيد، شکل به محل جديد انتقال مي‌يابد.
2-3-6 جابه‌جايي گره‌هاي يک مسير 

 1- نق��اط روي مس��ير را که مي‌خواهيد جابه‌جا ش��وند ب��ا اب��زار Pointer  انتخاب کنيد 
)شكل 6-12(.

2- نقط��ه مزب��ور را به موقعيت جديدي انتقال دهيد، بدين ترتيب ش��کل مس��ير تغيير 
مي‌کند )شكل 6-13(.

 

شکل 12-6  انتخاب گره روي مسير توسط ابزار Pointer         شکل 13-6 جابه‌جايي گره‌هاي يک مسير
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3-3-6 تغيير اندازه موضوعات گرافيکي

1- با ابزار Pointer روي شکل مورد نظر دابل کليک کنيد. با انجام اين کار دستگيره‌هاي 
تغيير شکل )Transform handles( در اطراف شکل ظاهر مي‌شود.

                                                                   

شکل 14-6 ظاهر شدن کادر مرزي

2- با قرار دادن ماوس روي اين دس��تگيره‌ها و درگ به س��مت داخل يا خارج مي‌توانيد 
اندازه)Scale(  شکل را تغيير دهيد )شكل 6-15(.

شکل 15-6 تغيير مقياس تصوير

3- با قرار دادن ماوس روي اين دس��تگيره‌ها و چرخش اش��اره‌گر مي‌توانيد ش��کل را در 
جهت دلخواه بچرخانيد.

مثال 4: آرم شكل 16-6 را رسم کنيد.
 

1- براي رسم آرم بايد از ابزار Pen استفاده کنيد و در نقاط گوشه شکل، استفاده از کليد
Alt  را فراموش نکنيد.

2- با ابزار Pointer  روي ش��کل مورد نظر دابل کليک کنيد تا دستگيره‌هاي تغيير شکل، 
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در اطراف شکل ظاهر شود )شکل 6-17(.
3- حال با درگ ماوس به سمت داخل، شکل را کوچک کنيد.

                     

شکل 16-6       شکل 17-6 ظاهر شدن دستگيره‌هاي تغييرشکل

4-3-6 انتخاب چندين موضوع گرافيکي به صورت همزمان

1- به وس��يله ابزار Pointer و نگه داشتن کليدShift ، مي‌توان چندين موضوع را با هم در 
حالت انتخاب قرار داد.

2- با انتخاب ابزار Pointer و کشيدن کادري توسط ماوس به دور همه موضوعات مي‌توان 
چندين موضوع را انتخاب کرد )شكل 6-18(.

شکل 18-6 انتخاب چند موضوع گرافيکي با يکديگر

 مثال 5: شکل‌هاي 19-6 را رسم کنيد.
1- براي رسم اين اشکال از ابزار Pen و Bezigon و براي رسم دايره‌هاي موجود در شکل 

از ابزار Ellipse به همراه کليد Shift استفاده کنيد.
2- کليه اشکال 19-6 را با هم انتخاب کنيد.

شکل 6-19 

دو روش براي اين کار وجود دارد:
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روش اول: مي‌توانيد به وس��يله ابزار Pointer و نگه داش��تن کليد Shift روي هر موضوع 
کليک کنيد و آن‌ها را با هم در حالت انتخاب قرار دهيد.

روش دوم: مي‌توانيد ابزار Pointer را انتخاب کرده توس��ط ماوس به دور همه موضوعات 
کادري رسم کنيد. در اين حالت تمام موضوعات در حالت انتخاب قرار مي‌گيرند.

5-3-6 حذف موضوعات گرافيکي

1- موضوع گرافيکي را با ابزار Pointer انتخاب کنيد.
2- کليدDelete  روي صفحه کليد را فشار دهيد.

 توجه: با استفاده از گزينه Clear  واقع در منوي Edit  مي‌توانيد موضوع‌ يا موضوعات 
انتخاب ‌شده‌ را حذف کنيد.

با دابل کليک روي ابزار Pointer کادر محاورهPointer Tool  ظاهر مي‌شود.

Pointer Tool شکل 20-6 کادر محاوره

هنگام انتخاب اش��کال گرافيکي توس��ط ابزار  Pointer بايد اشکال کاملًا درون کادر رسم 
شده توسط اين ابزار قرار گيرند تا انتخاب شوند، اما فعال کردن گزينه Contact sensitive از 
کادر محاوره Pointer Tool باعث مي‌ش��ود موضوعاتي هم که فقط قس��متي از آن‌ها در کادر 

رسم شده توسط ابزار Pointer قرار گرفته، به حالت انتخاب درآيند.

Contact sensitive شکل 21-6 عملکرد گزينه

 FreeHand روش‌هاي مختلفي براي انتخاب موضوعات گرافيکي در  Pointerعلاوه بر ابزار
MXa وجود دارند که عبارتند از:

1- فرم�انAll  )کليد ميانبر Ctrl+A(: از فرم��ان Edit→Select→All براي انتخاب همه 
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موضوع��ات موجود در صفحه به‌کار مي‌رود. اين فرمان موضوعات خارج از صفحه گرافيکي را 
در حالت انتخاب قرار نمي‌دهد.

 :)Ctrl+Shift+A  کليد ميانبر(  All In Document 2- فرمان
فرم��انSelect→All In Document از منوي Edit براي انتخاب تمام موضوعاتي که در کل 
 FreeHand س��ند وجود دارند، به‌کار مي‌رود )شكل 22-6(. )توجه داشته ‌باشيد که اسناد در

مي‌توانند شامل چندين صفحه باشند.(

شکل 22-6 انتخاب تمام موضوعات داخل سند

3- فرم�انNone  )کليد ميانبر Ctrl+D(: فرم��ان Select→None  از منوي Edit باعث 
مي‌شود موضوعات گرافيکي انتخاب شده، از حالت انتخاب خارج شوند. 

4- فرم�ان Invert Selection: فرم��ان Select→Invert Selection از من��وي Edit ب��راي 
معک��وس ک��ردن موضوعات انتخابي در داخل صفحه به‌کار م��ي‌رود. به طوري كه موضوعات 
انتخابي از  حالت ‌انتخاب خارج‌ش��ده و س��اير موضوعات به‌حالت انتخاب در مي‌آيند )شك��ل 

.)6-23

Invert Selection شکل 23-6 نتيجه استفاده از فرمان

5- فرمان Subselect: فرمان Select→Subselect از منوي Edit باعث مي‌شود همه اجزاي 
قرار گرفته در يک گروه به حالت انتخاب درآيند. همچنين در صورت اجراي اين فرمان روي 
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يک مسير انتخاب شده، گره‌ها و دستگيره‌هاي کنترلي آن مسير نمايان مي‌شوند.

 توج�ه: براي انتخ��اب يک موضوع خ��اص از ميان چند موض��وع موجود در يک 
گ��روه به جاي اجراي فرمان Subselect، مي‌توانيد از ابزار Subselect موجود در جعبه ابزار نيز 

استفاده کنيد.
    

شکل 24-6 انتخاب تمام اجزاي موجود در يک شکل يا مسير    

 نكت�ه: اب��زار Pointer  کل مجموعه گروه را انتخاب مي‌کند و اجزاي گروه از اين 
طريق انتخاب نمي‌شوند، براي انتخاب اجزاي يک گروه، از ابزار Subselect  استفاده کنيد.

Subselect شکل 25-6 ابزار

Subselect شکل 26-6 انتخاب يک جزء از يک گروه توسط ابزار

6- فرمان Superselect: انتخاب گزينه Select→Superselect از منوي Edit باعث مي‌شود 
اگر موضوعي )قس��متي( از يک گروه توسط Subselect انتخاب شده باشد، کل گروه به حالت 

انتخاب درآيد. با انتخاب فرمان Superselect دستگيره‌هاي شکل ناپديد مي‌شوند.
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Superselect شکل 27-6 عملکرد فرمان

تمرين 2: پنج مدل برگ را به دلخواه رسم كنيد و روش‌هاي انتخاب را روي آن 
بررسي كنيد.

تمرين 3: تصاوير 28-6 را رسم کنيد.

شکل 6-28       

 Freeform 4-6  ابزار

ابزار Freeform )تغيير ش��کل آزاد( داراي کاربردهاي بس��ياري است و در جعبه‌ابزار قرار 
دارد. ب��ه کم��ک اين ابزار مي‌توان گره‌ها را در مس��يرها به راحتي جابه‌جا کرد و مس��يرهاي 
ترس��يم ش��ده را به اش��کال دلخواه ويرايش کرده و تغيير ش��کل داد. اين ابزار با هل دادن، 
کش��يدن، افزودن گره يا حذف گره از مس��يرها به ويرايش و تغيير ش��کل آن‌ها مي‌پردازد و 

شکل جديدي را به وجود مي‌آورد.
علاوه بر تغيير ش��کل مس��يرها از طريق نقاط گره، اگر با اس��تفاده از ابزار Freeform در 
نقطه‌اي از صفحه  در خارج از مس��ير کليک کنيد و كليد ماوس را پايين نگه داريد، اشاره‌گر 
ماوس به يک دايره تبديل مي‌ش��ود و اگر آن را به لبه‌هاي مسير نزديک کنيد، خطوط آن را 

به سمت بيرون هل مي‌دهد.
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Freeform شکل 29-6 استفاده از ابزار

اب��زار Freeform داراي دو حالت Push/Pull وReshape Area  اس��ت. گزينه Push/Pull به 
ش��ما امکان مي‌دهد تا به منظور افزودن پاره‌خط‌هاي جديد به يک مسير، آن‌ها را بکشيد يا 

به داخل هل دهيد. انتخاب گزينهReshape Area  باعث تغيير شکل موضوع مي‌شود.

 مثال 6: شکل الف را رسم کرده سپس با ابزار Freeform آن را به شکل ب تبديل 
کنيد )شکل 6-30(.

1- ابت��دا ابزار Rectangle را از جعبه اب��زار انتخاب کرده، کليد Shift را پايين نگه داريد و 
روي صفحه يک مربع رسم کنيد. 

2- اکن��ون مي‌توانيد با اس��تفاده از اب��زار Freeform که از جعبه اب��زار انتخاب کرديد با 
کشيدن و هل دادن اضلاع مربع، شکل مورد نظر را ايجاد کنيد. 

شکل 6-30 

Push/Pull 1-4-6 تنظيم عمليات ابزار

 Freeform Tool در جعبه ابزار دابل کليک کنيد تا کادر محاوره Freeform 1- روي گزينه
مطابق شکل 31-6 باز شود.

2- از قسمت Tool Operation گزينه Push/Pull را انتخاب کنيد.
3- در قس��مت Push Settings با اس��تفاده از کادر Size  اندازه ابزار و با اس��تفاده از کادر 
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Precision ميزان حساسيت ابزار را تعيين کنيد. 

4- در قسمت Pull Settings نوع کشيدن مسير براي ابزار Freeform تعيين مي‌شود.

                                 

Push Settings شکل 32-6 تنظيمات قسمت          Freeform Tool شکل 31-6 کادر محاوره

 ، By Lengthدو حالت براي انتخاب وجود دارد. با انتخاب حالت  Bend5- در كادر بازش��و
ابزار Freeform مس��يرها را براس��اس پهنايي که توسط دکمه لغزندهLength  تعيين مي‌شود، 
 تغيير مي‌دهد. انتخاب Between Points فقط قس��متي از مس��ير را که بين گره‌ها قرار دارد، 

مي‌کشد.   

                                                         

Length شکل 34-6 تنظيمات دکمه لغزنده         Pull Settings شکل 33-6 تنظيمات قسمت

 Push/Pull 2-4-6 اصلاح موضوعات در حالت

1- موضوعي را که مي‌خواهيد اصلاح شود، برگزينيد.
2- اشاره‌گر ماوس را در موقعيت‌هاي زير قرار دهيد:

• کوچک در  	s اش��اره‌گر ماوس را مس��تقيماً روي مرز موضوع قرار دهيد تا يک شکل
کنار آن ظاهر ش��ود. اين شکل نشان مي‌دهد که در حالت کشيدن )Pull( هستيد و 

تنها کافي است لبه موضوع مربوطه را به داخل يا خارج درگ کنيد.
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Pull و Push شکل 35-6 نمايش اشاره‌گر در حالت

• کوچک در کنار  	o اش��اره‌گر ماوس را به داخل يا خارج موضوع انتقال دهيد تا شکل
آن ظاهر شود. اين شکل نشان مي‌دهد که شما در حالت )Push( هستيد.

3- براي اصلاح موضوع، ماوس را بکشيد؛ در حالت Push دايره‌اي ظاهر مي‌شود که اندازه 
آن را با اس��تفاده از کادر Size در قس��مت Push Settings تنظيم کرده‌ايد. وجود يک پيکان 

نشان دهنده اين است که در حالت Pull قرار داريد.
• اثر هل‌دادن يا کشيدن مسيرها به‌صورت ظريف‌تري انجام مي‌شود  	Reshape درحالت
که براي ترس��يم جزييات بيش��تر تصاويري مثل موي سر، س��اقه گياهان و ... مفيد 

خواهند بود.

Pull و Push شکل 36-6 نمايش اشاره‌گر هنگام اصلاح شکل در حالات

Reshape Area 3-4-6 تنظيم عمليات گزينه

 Freeform Tool در جعب��ه ابزار دابل کليک کنيد تا کادر محاوره Freeform 1- روي‌اب��زار
باز شود.

2- از قسمتTool Operation  گزينه Reshape Area را برگزينيد )شكل 6-37(.       
3- در قس��مت Settings، براي تنظيم اندازه ن��وک ابزار از کادر Size و براي تنظيم ميزان 
يا مدت زمان کش��ش ابزار از کادر  Strength اس��تفاده کنيد. گزينه Precision  تعداد گره‌هاي 

لازمي را که در طول مسير تحت تأثير قرار مي‌گيرد، تعيين مي‌کند )شكل 6-38(.
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Settings شکل 38-6 تنظيمات قسمت        Freeform Tool شکل 37-6 کادر محاوره

شکل 39-6 استفاده از ابزار Reshape Area براي اصلاح شکل

 نكته: هر قدر مقدار Precision بيش��تر باش��د، حساسيت ابزار شما به جابه‌جايي 
ماوس بيشتر شده و پس از استفاده از ابزار، تعداد نقاط گره بيشتري ايجاد مي‌شود.

  Push/Pull آن را بين دو حالت  Freeform هنگام استفاده از ابزار Alt  توجه: کليد 
و Reshape Area جابه‌جا مي‌کند.

تمرين 4: اش��کال 40-6 را رس��م کرده و تصاوير شماره 1 را به تصاوير شماره 2 
تبديل کنيد. 

'            

شکل 6-40 
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 Knife 5-6 ابزار
اب��زار Knife موجود در جعبه اب��زار، مانند چاقو عمل مي‌کند. اين ابزار موضوعات را برش 
مي‌زند و حفره‌هايي درون آن‌ها به وجود مي‌آورد و حتي مي‌تواند بخش��ي از اش��کال را پاک 

کند.
Knife 1-5-6 تنظيمات ابزار

1- در جعب��ه اب��زار روي ابزار Knife داب��ل کليک کنيد تا کادر مح��اوره Knife Tool باز 
شود.

2- در قسمت Tool Operation با استفاده از گزينه Freehand  مي‌توانيد برش‌هاي موجي 
 Straight شکل ايجاد کنيد يا بر اساس حرکت ماوس شکل را برش بزنيد، اما با انتخاب گزينه

مي‌توانيد موضوعات را به‌طور خطي مستقيم و صاف برش بزنيد.

                
Straight و   Freehand در حالت  Knifeشکل 42-6 نحوه برش با ابزار      Knife Tool  شکل 41-6 کادرمحاوره

3- در قس��مت Width مي‌توانيد فاصله بين برش‌ها يا پهناي نوک چاقو را هم به صورت 
دستي و هم با اهرم کناري آن تنظيم کنيد )شكل 6-43(.

شکل 43-6 فاصله برش

 نكته: زماني که مي‌خواهيد شکل خود را به صورت مسير بسته ببريد، بهتر است 
پهنا را صفر بدهيد تا دو شکل بريده شده به هم بچسبند و از هم جدا نشوند.
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4- گزينه Close cut paths در قس��مت Options باعث مي‌ش��ود مسيرهاي برش خورده، 
بس��ته شوند )شك��ل 44-6(. گزينه Tight fit نيز سبب مي‌ش��ود ابزارKnife  دقيقاً از حرکت 

ماوس پيروي کند.

Close cut paths      شکل 44-6 عملکرد گزينه

Knife 2-5-6 استفاده از ابزار

1- موضوعي را که مي‌خواهيد برش بزنيد، انتخاب کنيد.
2- ابزار Knife را روي موضوعات بکشيد.

  Alt از کليد Straight و Freehand توج�ه: براي جابه‌جايي س��ريع بين دو حال��ت 
استفاده کنيد. 

مثال 7:  شکل 45-6 را رسم کنيد.
 Ellipse و براي رسم چشم‌ها از ابزار Bezigon و Pen 1- براي‌ رس��م اين شکل از ابزارهاي

استفاده کنيد.
2- ش��کل را به صورت موجي شکل، برش بزنيد به طوري که فاصله بين برش‌ها 3 باشد 

و پس از برش مسيرهاي ايجاد شده بسته باشند.	           

 شکل 6-45 

ب��راي اي��ن منظور ابتدا در جعبه ابزار روي ابزار Knife داب��ل کليک کنيد تا کادر محاوره 
Knife Tool باز ش��ود، سپس در قسمت Tool Operation گزينهFreehand  را انتخاب کنيد تا 

برش‌ها به صورت موجي ش��کل ايجاد شود. بعد در قسمت Width فاصله بين برش‌ها را برابر 
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3 قرار دهيد و در قسمت Options گزينه Close cut paths را انتخاب کنيد تا مسيرهاي برش 
خورده، بسته شوند و در انتها ابزار Knife را روي تصوير بکشيد.

تمرين 5: شكل 46-6 را ايجاد کرده و برش‌هاي لازم را انجام دهيد.                            

شکل 6-46 

 توج�ه: ب��راي رنگ‌آمي��زي موضوعات و اشك��ال مي‌تواني��د در جعبه اب��زار، ابزار 
را ب��راي رن��گ خطوط دور شك��ل و Fill Color   را براي رنگ‌آميزي    StrokeColor

داخل شكل استفاده كنيد1.

 Eraser 6-6 پاک کردن مسير با ابزار
با استفاده از ابزار Eraser مي‌توانيد قسمت‌هايي از مسير انتخابي يا اشکال را پاک کنيد.

 Eraser 1-6-6 پاک کردن مسير انتخابي با ابزار

1- شکل يا مسير مورد نظر را انتخاب نماييد.
2- از جعبه ابزار Tools روي ابزار Eraser کليک کنيد.
3- ابزار Eraser را روي مسير مورد نظر درگ نماييد.

Eraser 2-6-6 تنظيم گزينه‌هاي ابزار

در جعبه ابزارTools  روي ابزار Eraser دابل کليک كنيد.
در قسمت Min و Max مي‌توانيد با وارد كردن عددي بين 0 تا 72 يا با حركت نوار لغزنده 

حداقل و حداكثر پهنا را تعيين نماييد.

1- با روش‌هاي ديگر رنگ‌آميزي در واحدكار 7 آشنا خواهيد شد. 
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Eraser شکل 47-6 کادر تنظيمات ابزار

تمرين 6: ش��کل 48-6 را رسم و سپس با تنظيم پهناي پاك‌كن، قسمت‌ مياني 
شكل را پاك كنيد.

شکل 6-48

 Lasso 7-6 انتخاب اشکال با  ابزار
مي‌توان توسط ابزارهايSubselect، Pointer  و  Lassoو کليک روي اشکال، آن‌ها را انتخاب 

نمود. 
ابزارهاي Pointer و Subselect به ش��ما اين امکان را مي‌دهند تا با کليک روي ش��کل يا 
درگ روي ش��کل يا نقطه به صورت مس��تطيل آن را انتخاب نماييد اما با ابزارLasso  مي‌توان 

به صورت آزاد )Freeform( اشکال يا نقاط مورد نظر را انتخاب كرد.
Lasso 1-7-6 تنظيمات ابزار

با دابل کليک روي ابزار Lasso کادرمحاورهLasso Tool  باز مي‌شود )شکل 49-6(. هنگام 
انتخاب اش��کال گرافيکي توس��ط ابزار Lasso توجه داشته باشيد كه اشکال کاملًا درون کادر 
 Contact رس��م ش��ده توس��ط اين ابزار قرار گيرند تا انتخاب ش��وند، اما فعال کردن گزينه
sensitive از کادر مح��اوره Lasso Tool  باع��ث مي‌ش��ود موضوعاتي انتخاب ش��وند كه فقط 

قسمتي از آن‌ها )نه همه اجزاي شكل( درون كادر Lasso قرار گرفته است.

Lasso Tool شکل 49-6 کادر
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در شكل 50-6 انتخاب با ابزار Lasso در هنگام فعال‌بودن گزينه Contact sensitive نشان‌ 
داده‌شده‌است.

Contact sensitive در هنگام فعال بودن گزينه Lasso شکل 50-6 نحوه عملكرد ابزار

 Connector 8-6 ابزار
به منظور اتصال اش��کال به يکديگر توسط اين ابزار مي‌توان خطوط اتصال دهنده را بين 

آن‌ها ترسيم كرد.

شکل 51-6 استفاده از خطوط اتصال 

هنگام��ي که اش��کال متصل به ه��م را در پنج��ره Documents حرک��ت دهيد، خطوط 
Connector به طور خودکار نسبت به وضعيت جديد تنظيم مي‌شوند.

1-8-6 رسم يک خط اتصال بين دو شئ 

1- صفحه‌جديدي ايجاد کرده و دو شکل در قسمت‌هاي مختلف صفحه رسم کنيد.
2- از جعبه ابزار Tools روي‌ ابزار Connector کليک كنيد.

3- مکان‌نماي ماوس را )که ش��کل آن تغيير کرده اس��ت( روي يکي از اشکال قرار دهيد 
كه مي‌خواهيد خط اتصال‌دهنده از آنجا ش��روع شود. حال يک دايره کوچک کنار آن نمايان       

مي‌شود. 
4- در اين حالت کليک کرده و ماوس را به س��مت بالا، پايين يا وجوه شك��لي بكشيد كه 

مي‌خواهيد به آن متصل شويد.
5- پس از مشاهده دايره كوچك، كليد ماوس را رها كنيد. يک خط به شکل دوم ترسيم 
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مي‌شود.

 )Start( مي‌توانيد تنظيمات مربوط به نقاط ابتدا Object نكته: با اس��تفاده از پنل 
و انتهاي )End( خطوط Connector را انجام دهيد.

2-8-6 تغيير اندازه و تغييرشكل خط اتصال دهنده 

براي تغيير اندازه خط اتصال دهنده، هنگامي كه ابزار Connector در حال انتخاب است، 
مکان‌نما را روي خط قرار دهيد تا به شکل پيکان دو سر به همراه علامت بعلاوه ديده شود، 

سپس خط را به دلخواه درگ کنيد، در اين صورت شكل خط و اندازه آن تغيير ميك‌ند.

 توجه: هنگام جابه‌جايي اش��ياء توس��ط ابزار انتخاب، خط اتص��ال دهنده به طور 
خودكار تغيير شكل مي‌دهد تا دو شئ را به هم وصل كند.

تمرين 7: شكل 52-6 را رسم كنيد.

شکل 6-52

 Edit 9-6 برخي از فرمان‌هاي منوي
همان‌طورکه می‌دانيد منوی Edit به منظور کارهای ويرايشی نظير کپی، برش و چسباندن 
يک ش��ئ روی صفحه به‌کار می‌رود. در اين بخش به فرمان‌های تخصصی ويرايشی پرداخته 

شده است.
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Edit شکل 53-6 منوي
Cut Contents 1-9-6 فرمان

اين گزينه براي جدا کردن موضوعاتي که داخل هم قرار گرفته‌اند، اس��تفاده مي‌ش��ود. به 
عبارت ديگر اين گزينه عکس عمل Paste Contents را انجام مي‌دهد. براي اجراي اين گزينه 

ابتدا بايد فرمانPaste Contents را انجام دهيد.
Paste Contents  فرمان

اين فرمان در نس��خه FreeHand MXa موجود است و باعث كپي كردن و چسباندن يك 
شكل به درون يك مسير يا شكل ديگر مي‌شود به طوري كه شكل چسبانده شده در لبه‌هاي 

مسير برش بخورد.
به عبارت ديگر چسباندن شئ در داخل شئ ديگر به شما امکان می‌دهد تا اشيای مزبور 
را به نحوی پر کنيد که تمام بخش‌های خارج از آن‌ها ديده نش��ود. اين ش��ئ پر ش��ده، يک 
مس��ير برش )Clipping Path( يا ماس��ک ناميده می‌ش��ود. برای انجام ماسک‌گذاری اشياء به 

روش زير عمل کنيد:
1- ابتدا بايد تصوير يا اشيای مورد نظر را روی شيئی قرار دهيد که به عنوان مسير برش 

عمل می‌کند، سپس آن‌ها را انتخاب کنيد )شكل 6-54(.
2- ب��ا اس��تفاده از فرمان Edit→Cut  اش��ياء را در کليپ‌بورد ق��رار دهيد، در اين صورت 

مطابق شکل 73-6 فقط مسير روی صفحه می‌ماند.
3- حال مسير برش را انتخاب نماييد سپس فرمان Edit→Paste Contents  را اجرا كنيد 

تا اشياء در مسير برش چسبانده شوند )شکل 6-56(.
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شکل 54-6 قرار گرفتن اشياء روی مسير برشی    شکل 55-6 نمايش مسير پس از انتقال اشياء به کليپ‌بورد

 نكت�ه: اگر در پن��ل Object روي گزينه Content كليك كنيد يک دس��تگيره در 
ش��کل ظاهر می‌شود که با درگ اين دس��تگيره در جهت‌های مختلف، اشياء در مسير برش 

جابه‌جا می‌شوند.

       	

شکل 56-6 نمايش نتيجه فرمان Paste Contents      شکل 57-6 نمايش دستگيره در مسير برشی

حال فرمان Cut Contents را اجرا نماييد، مش��اهده ميك‌نيد كه اشك��ال از مس��ير برشي 
خارج مي‌شوند.

Cut Contents شکل 58-6 نمايش اجراي فرمان

 )Clipping Path( براي حذف مس��ير برش��ي Cut Contents نكته: در واقع فرمان 
بهك‌ار مي‌رود.

Paste Special 2-9-6 فرمان

اين گزينه براي چسباندن شئ مورد نظر از يك برنامه كاربردي به برنامهFreeHand  بهك‌ار 
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مي‌رود.
براي انجام اين عمل مراحل بعد را انجام دهيد:

1- موضوع مورد نظر در برنامه كاربردي را كپي كنيد.
2- در برنامه FreeHand از مس��ير Edit→Special  فرمان Paste Special را اجرا كنيد. كادر 

محاوره Paste Special باز خواهد شد )شكل 6-59(.

Paste Special شکل 59-6 كادرمحاوره

3- از كادر  As:فرمت موردنظر را انتخاب كرده و دكمه OK را كليك كنيد.
تمرين 8: شك��لي را كه در برنامه فتوشاپ رس��م كرديد، كپي كنيد و سپس در 

برنامه FreeHand آن را Paste Special نماييد.
 Duplicate  3-9-6 فرمان

در برنام��ه FreeHand  فرماني در اختيار ش��ما قرار مي‌گيرد ��كه موضوعات مورد نظر را 
ب��ه نحوي كپي ميك‌ن��د كه در كليپ‌بورد قرار نمي‌گيرد و اصطلاحاً به آن مضاعف كردن هم 

مي‌گويند. براي انجام فرمان Duplicate مراحل بعد را انجام دهيد:
1- موضوع مورد نظر را انتخاب كنيد.

2- از من��وي Edit گزين��ه Duplicate را برگزيني��د ي��ا مي‌توانيد همزم��ان كليدتركيبي 
Alt+Ctrl+D را بفشاريد. در اين صورت يك كپي از شكل ايجاد مي‌شود به طوري كه دورتر از 

شكل اصلي قرار مي‌گيرد. سه بار عمل Duplicate انجام شده است.
Clone  4-9-6 فرمان

اين گزينه درس��ت روي خود موضوع انتخابي يک رونوشت از شئ ايجاد مي‌کند و معادل 
كليدي آن Ctrl+Shift+D اس��ت. در اين صورت مي‌توان به كمك كليد Shift شكل كپي شده 

را در راستاي شكل اصلي جابه‌جا كرد.

تمرين 9: شك��ل 60-6 را رس��م كرده و تفاوت فرمان‌ه��اي Duplicate ،Copy و 
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Clone را بررسي كنيد.

شکل 6-60

 مث�ال كاربردي: در ادامه مثال كاربردي واح��د كار 5، فايلProject. fh11 را كه 
قبلًا ايجاد كرده‌ايد، باز كنيد و موارد بعد را انجام دهيد. 

1- با استفاده از ابزار Subselect روي نقطه لنگر پايين ضلع سمت راست چهارگوش كليك 
 كنيد تا انتخاب شود. نقاط لنگر پس از انتخاب به صورت مربع توخالي نمايش داده مي‌شوند 

)شکل 6-61(.
2- اكنون در پنل Object مش��خصات گره انتخاب ش��ده نمايش داده مي‌شود. با انتخاب 
آيكن نقطه منحني در اين پنل، نقطه گوشه به يك نقطه منحني تبديل مي‌شود. حال گزينه
Automatic  را هم فعال كنيد تا خطوط متصل به نقطه انتخاب شده به كمان تبديل شوند.

3- نقطه را با اس��تفاده از ابزار Pointer كمي به داخل شك��ل منتقل كنيد تا كمان، شكل 
مناس��ب خ��ود را پيدا كند. براي اينك‌ه نقطه در زاوي��ه 45 درجه حركت كند، كليد Shift را 

نيز پايين نگه داريد.

                      

شكل 61-6                                         شكل 62-6                                  شكل 6-63

4- با ابزار Ellipse يك بيضي با ابعاد دلخواه ترسيم كنيد. 
5- در زبان��ه Object ابع��اد 22/5×22/5 را ب��راي قطرهاي بيض��ي وارد كنيد تا بيضي به 
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داي��ره‌اي با قطر 22/5 تبديل ش��ود. با اس��تفاده از اب��زار Pointer يا با اس��تفاده از كليدهاي 
جهت‌دار صفحه كليد دايره را حركت داده و بر رأس بالا و سمت چپ مستطيل از قبل ترسيم 

شده، مماس کنيد )شکل 6-64(.

شكل 6-64 

6- تغييرات را ذخيره كنيد.
واژه‌نامه

Createايجادکردن

Connectorاتصال‌دهنده

Concaveمقعر

Directionمسير، جهت

Expansionگسترش

Eraserپاک‌کن

Incrementافزايش

Knifeچاقو

Lassoکمند

Pointerاشاره‌گر

Radiusشعاع

Rotationچرخش

Spiralمارپيچ

Straightيکسره، مستقيم

Subselectزير انتخاب

خلاصه مطالب 
• اس��تفاده  	Arc ب��راي ترس��يم کمان )باز، بس��ته، محدب و مقعر( ي��ا منحني از ابزار
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مي‌شود.
• استفاده کنيد. 	Spiral براي ترسيم خطوط مارپيچ از ابزار

به منظور انتخاب، جابه‌جايي و حرکت دادن و تغيير اندازه موضوعات  • 	 Pointer  از ابزار
گرافيکي استفاده مي‌شود.

 • 	All براي انتخاب همه موضوعات موجود در صفحه به‌کار مي‌رود و فرمان All  فرم��ان
In Document ب��راي انتخاب تمام موضوعاتي که در کل س��ند وج��ود دارند، به‌کار 

مي‌رود.
• فرمان None موضوعات گرافيکي انتخاب شده را از حالت انتخاب خارج ميك‌ند.	

• براي معکوس کردن موضوعات انتخابي در داخل صفحه و  	Invert Selection  فرم��ان
فرمان Subselect باعث مي‌شود همه اجزاي قرار گرفته در يک گروه به حالت انتخاب 
درآيند. همچنين انتخاب فرمان Superselect باعث مي‌شود اگر موضوعي )قسمتي( از 

يک گروه توسط  Subselect انتخاب شده باشد، کل گروه به حالت انتخاب درآيد.
• مي‌توان گره‌ها را در مس��يرها به راحت��ي جابه‌جا کرد و  	Freeform ب��ه کمک اب��زار

مسيرهاي ترسيم شده را به اشکال دلخواه ويرايش کرده و تغيير شکل داد.
، مانند چاقو عمل مي‌کند. اين ابزار موضوعات را برش مي‌زند و حفره‌هايي  • 	Knife ابزار

درون آن‌ها به وجود مي‌آورد و حتي مي‌تواند بخشي از اشکال را پاک کند.
• مي‌توانيد قس��مت‌هايي از مسير انتخابي يا اشکال را پاک  	Eraser با اس��تفاده از ابزار

کنيد.
و کليک روي اش��کال آن‌ها را  • 	 Lasso و  Subselect ، Pointer مي‌توان توس��ط ابزارهاي

انتخاب كرد. 
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آزمون نظري
درستي يا نادرستي گزينه هاي زير را تعيين کنيد.

1- براي ترس��يم کم��ان )باز، بس��ته، محدب و مقعر( ي��ا منحني از ابزار Arc اس��تفاده 
مي‌شود.

2- ابزارSpiral  با هل دادن، کش��يدن، افزودن گره يا حذف گره از مس��يرها به ويرايش و 
تغيير شکل آن‌ها مي‌پردازد و شکل جديدي را به وجود مي‌آورد.

3- براي ترسيم خطوط مارپيچ از ابزار Subselect استفاده کنيد.
4- اب��زار Knife، موضوعات را برش مي‌زند و حفره‌هاي��ي درون آن‌ها به وجود مي‌آورد و 

حتي مي‌تواند بخشي از اشکال را پاک کند.
معادل گزينه هاي سمت‌ راست را از ستون سمت‌ چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

Alt                                                         .5- اين ابزار مانند چاقو عمل مي‌کند
 6- از اين ابزار به منظور انتخاب، جابه‌جايي و حرکت دادن موضوعات گرافيکي اس��تفاده 
Knife                                                                                              .مي‌شود
7- براي جابه‌جايي سريع بين دو حالت Freehand و Straight از اين کليد استفاده کنيد.                                                                                                                                            
                               Pointer                                                                                                    
8- به کمک اين ابزار مي‌توان مسيرهاي ترسيم شده را به اشکال دلخواه ويرايش کرده و 
 Freeform                                                                               .تغيير شکل داد

گزينه صحيح را انتخاب کنيد.

9- توسط ابزار Spiral چه عملي را مي‌توان انجام داد؟
ب- رسم مارپيچ الف- ايجاد سايه محو براي موضوع گرافيکي 	

د- رنگ‌آميزي خطوط پيرامون                                  ج- رنگ‌آميزي داخل موضوع گرافيکي      	
                                                                موضوع گرافيکي

10- چه مواقعي از ابزار Arc استفاده مي‌شود؟
ب- مقعر کردن شکل  الف- سه بعدي کردن شکل 	

د- رسم کمان 		 ج- قرينه کردن شکل
11- براي رسم کمان باز هنگام استفاده از ابزار Arc از کدام گزينه استفاده مي‌شود؟
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Create Flipped Arc -ب               	Create Open Arc -الف
Create Arc -د 	Create Concave Arc -ج
12- از ابزارKnife به چه منظور استفاده مي‌شود؟

ب- قرينه کردن تصاوير 		 الف- چرخاندن تصاوير
د- جابه‌جا کردن گره‌ها 		 ج- برش زدن تصاوير

13- کدام‌يک از عمليات زير توسط ابزار Pointer انجام مي‌گيرد؟
		         ب- جابه‌جا کردن تصوير الف- تغيير اندازه تصوير

ج- انتخاب چند تصوير همزمان            د- تغيير اندازه، جابه‌جايي و انتخاب هم‌زمان 
                                                    چند تصوير

13- ب��راي ب��رش تصاوير به صورت خط ص��اف کدام‌يک از گزينه‌ه��اي موجود در کادر 
محاوره Knife Tool بايد فعال باشد؟

Tight fit -د      	  Width -ج    	Straight -ب         Freehand -الف
14- فرمان ................... كپي شكل را روي خودش قرار مي‌دهد.

Duplicate -د     	  Clone -ج   	 Contents Cut‍ -ب         	 Copy‍‍-الف
در جاي خالي عبارت مناسب را بنويسيد.

15- براي انتخاب اجزاي يک گروه، از ابزار....................استفاده کنيد.
16- به وسيله ابزار Pointer و نگه داشتن کليدShift ، مي‌توان ........................ .

17- ابزار Connector به منظور ......................... مورد استفاده قرار مي‌گيرد.
18- براي تغيير جهت کمان در راستاي افقي و عمودي، پس از ترسيم، کليد .................. 

را نگه داريد.
به سؤالات زير پاسخ تشريحی دهيد.

19- تفاوت بين مارپيچ گسترشي و غيرگسترشي چيست؟
20- کاربرد ابزارPointer  را نام ببريد.

21- دو روش جابه‌جايي و انتقال موضوعات را نام ببريد.
22- براي تغيير شکل موضوع از کدام گزينه Freeform استفاده مي‌شود؟

23- تفاوت فرمان Cut Contents و Duplicate در چيست؟
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آزمون عملي 
1- شکل‌هاي زير را رسم كنيد سپس به‌وسيله ابزار Pointer آن‌ها را تغيير اندازه دهيد.

2- ش��کل‌هاي زير را رس��م نماييد سپس به‌وسيله ابزارهاي انتخاب قسمتي از آن‌ها را به 
دلخواه انتخاب کنيد.

3- س��ه كپي از شك��ل‌ فيل را در اطراف آن قرار دهيد )يك كپي ب��ا گزينه Duplicate و دو 
.)Clone كپي با فرمان

4- يک کمان به صورت قوس بسته يک چهارم دايره رسم كنيد.
5- با استفاده از ابزارهاي Arc و Spiral درياي مواج را ترسيم كنيد.
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كليات
در مبح��ث رنگ در FreeHand به دو بخ��ش بايد توجه کرد، يکي ترکيب و تضاد رنگ‌ها 
براي ايجاد يک اثر هنري و ديگري ش��ناخت س��اختار و مواد رنگ‌هاس��ت؛ چرا که تنها در 
صورت استفاده صحيح از سيستم مدل‌هاي رنگ، مي‌توان خروجي مناسبي از اثر تهيه کرد.

م��دل رنگ، روش‌ه��اي گوناگون ارائه رنگ روي کاغذ و صفح��ه نمايش را بيان مي‌کند؛ 
به طور کلي مدل‌ها براي معرفي رنگ‌ها اس��تفاده مي‌ش��ود. در اين واحد کار ابتدا به بررسي 
ان��واع مدل‌هاي رنگ پرداخته و س��پس نحوه ايجاد و رنگ‌آمي��زي موضوعات گرافيکي گفته 

مي‌شود.
1-7 مدل‌هاي رنگ و کاربردهاي آن‌ها

چش��م انسان رنگ‌ها را براس��اس طول موج نوري که به آن مي‌رسد، درک مي‌کند. رنگ 
سفيد، نوري است که همه رنگ‌هاي اصلي طيف رنگ را در برمي‌گيرد.

چندين مدل رنگ در FreeHand وجود دارد که اساس کار همه آن‌ها طيف نور يا انعکاس 
نور تابيده شده از جسم رنگي است.

 نكت�ه: مدل‌هاي رنگ در FreeHand، اس��اس تفکي��ک رنگ براي صنعت چاپ و 
ذخيره‌سازي اسناد در قالب‌هاي مختلف گرافيکي است.

 RGB مدل
طيف نور مرئي از س��ه رنگ اصلي قرمز )Red(، س��بز )Green( و آبي )Blue( تشکيل شده 

است و رنگ‌ها در اين مدل از ترکيب اين سه رنگ حاصل مي‌شوند )شکل 7-1(. 
ب��راي ايجاد تصوير در تلويزيون، صفحه نمايش يا انتش��ار در صفحات وب از مدل رنگي 

RGB استفاده مي‌شود. در مدل RGB دانستن نکات زير ضروري است:

1- هر يک از رنگ‌ها با عددي بين 0 تا 255 نشان داده مي‌شوند.
2- رنگ سفيد در اين مدل به معناي آن است که هر سه رنگ اصلي به طور کامل با هم 

ترکيب شده‌اند.
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FreeHand در RGB شكل 1-7 مدل رنگ

3- رنگ سياه در RGB عدم وجود نور براي چشم انسان است، يعني اين که هر سه مؤلفه 
رنگ صفر باشند.

4- رنگ‌هاي از نوع RGB رنگ‌هاي افزايشي هستند؛ چرا که اگر سه رنگ اصلي همزمان 
با هم جمع شوند و به نقطه‌اي بتابند، رنگ سفيد را نتيجه مي‌دهند.

RGB شكل 2-7 نمايش مدل رنگ

 CMYK مدل
اين مدل رنگ بر اس��اس جوهرهاي چاپ که روي کاغذ س��فيد جذب مي‌ش��وند، ساخته 
مي‌ش��ود؛ به عبارت ديگر بازگش��ت رنگ به سوي چشم اس��ت که تصوير را مي‌سازد )شکل 

.)7-2
رنگ‌ها در مدل CMYK از ترکيب چهار رنگ انعکاسي ساخته مي‌شود که عبارتند از:

آبي فيروزه‌اي )Cyan(، ارغواني )Magenta(، زرد )Yellow( و سياه )BlacK(. رنگ سفيد در 
اين مدل يعني اين که هر چهار رنگ مقدارش صفر باشد و نور را منعکس کند.
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FreeHand در  CMYKشكل 3-7 نمايش مدل رنگ

 توجه: در مدل CMYK تمامي رنگ‌ها از تركيب چهار رنگ اصلي ساخته مي‌شوند 
)شکل 7-4(.

CMYK شكل 4-7 نمايش مدل رنگ

در مدل CMYK بايد به نکات زير توجه داشته باشيد: 
1- م��دل CMYK در صفحه نمايش هرگز به صورت صحيح ديده نمي‌ش��ود، زيرا صفحه 
نمايش منبع توليد رنگ RGB اس��ت و تصاوي��ر و رنگ‌هايي كه در FreeHand براي چاپ در 
نظر گرفته مي‌ش��وند؛ بايد در مدل CMYK پردازش ش��وند تا با جوهرهاي چاپ س��ازگاري 

داشته باشند.
2- به رنگ‌هاي از نوع CMYK رنگ‌هاي کاهش��ي نيز مي‌گويند که از ترکيب کامل همه 
آن‌ها با يکديگر رنگ س��ياه ساخته مي‌ش��ود و اگر تمام رنگ‌ها از هم کم شوند سطح سفيد 

کاغذ نمايان مي‌شود و نور را منعکس مي‌سازد.
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	HLS مدل
م��دل HLS يک��ي از انواع سيس��تم رنگ RGB اس��ت. اين مدل رنگ ش��امل نوع و مايه 
 رن��گ )Hue(، مي��زان روش��نايي )Lightness( و اش��باع يا غلظت رنگي )Saturation( اس��ت

)شکل 7-5(.

FreeHand MX در HLS شکل 5-7 نمايش مدل رنگ

در اينجا Hue، رنگ پايه را بر اس��اس چرخه رنگ مش��خص مي‌کند و مقدار آن بر اساس 
 L .درجه و عددي بين صفر تا 360 اس��ت که مش��خص کننده رنگ روي چرخه رنگ اس��ت
معرف درصد نور و روش��ني رنگ اس��ت که 0% معرف رنگ سياه و 100% نشانه رنگ سفيد 

است.
S ميزان خلوص رنگ است، رنگ‌هاي خالص رنگ‌هايي هستند که هيچ مقدار خاکستري 
ندارند و غلظت آن‌ها 100% اس��ت. هرچه به مرکز چرخه رنگ نزديک ش��ويم درصد غلظت 

رنگ کاهش مي‌يابد. 
تمرين 1:  بررسي کنيد، به چه دليل مدل رنگ CMYK براي صفحه‌ها و سندهاي 

وب مناسب نيست؟  

تمرين 2: مدل System Color Picker را بررسي کنيد.

2-7 پنل‌هاي رنگ 
FreeHand ابزارهاي��ي را ب��راي رنگ‌آمي��زي به ص��ورت پنل در نظر گرفته اس��ت. براي 

رنگ‌آميزي مسيرهاي بسته معمولاً از پنل  Color Mixer و  Swatches استفاده مي‌شود.
اين دو پنل به روش‌هاي زير در صفحه نمايش ظاهر مي‌شوند:

Window 1- انتخاب پنل‌ها از منوي
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2- کلي��ک روي آيکن  براي باز کردن پن��ل Color Mixer و کليک روي آيکن  
Main از نوار ابزار اصلي يا  Swatches براي باز کردن پنل

3- کليد ميانبر Shift+F9 پنل Color Mixer و Ctrl+F9 پنل Swatches را در دسترس قرار 
مي‌دهد.

 Color Mixer 1-2-7 ايجاد رنگ با پنل

اين پنل كه با عنوان Mixer ديده مي‌شود براي ساختن رنگ‌هاي ترکيبي مورد نياز به‌کار 
مي‌‌رود. 

Color Mixer شکل 6-7 پنل

در پايين پنل، رنگ ايجاد ش��ده و اصلي مطابق شکل 6-7 قابل مشاهده است، در سمت 
چپ اين پنل مي‌توانيد از چهار حالت مختلف براي ميکس يا ترکيب کردن رنگ‌ها اس��تفاده 
کنيد که پيش از ش��روع به س��اختن رنگ‌ها لازم اس��ت؛ حالت )mode( رن��گ مورد نظر را 
تعيي��ن کنيد. اين حالت‌ها عبارتن��د از HLS ،RGB ،CMYK وColor  System )رنگ‌هاي آماده  

.)Windows

 Main را با استفاده از نوار ابزار  Color Mixerتمرين 3: نمايش و عدم نمايش پنل
در صفحه نشان دهيد.

CMYK کار با رنگ
همان‌طورکه گفته ش��د براي کارهاي چاپي از مدل CMYK استفاده مي‌شود، رنگ مورد 

نظر را مي‌توانيد هم به صورت عددي و هم با استفاده از دكمه لغزنده کنار آن ايجاد کنيد.
رنگ س��اخته ش��ده در نوار پايين پنجره قابل مش��اهده اس��ت. حال مي‌توانيد رنگ را از 

جوهردان، درگ کرده و روي موضوع مورد نظر قرار دهيد )شکل 7-7(.
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شکل 7-7 نحوه رنگ‌‌آميزي موضوع

RGB کار با رنگ
براي کارهاي نمايش��ي و اينترنتي از مدل رنگ RGB اس��تفاده مي‌کنند. نحوه استفاده از 

رنگ RGB مانند رنگ CMYK است.
 HLSکار با رنگ

همان‌طورکه قبلًا گفته ش��د، مدل HLS يکي از انواع سيس��تم رنگ RGB اس��ت و ميزان 
غلظ��ت و روش��نايي و مايه رنگ را از طري��ق دکمه لغزنده يا به ص��ورت درصدي با درج در 

کادرهاي عددي مشخص مي‌کند.
System Color Picker  کار با رنگ

اگر بخواهيد از رنگ‌هايي که براي سيستم عامل در نظـر گرفته شده استفاده کنيد،
System Color Picker امکان استفاده از 48 رنگ اصلي ويندوز را فراهم مي‌کند.

تمرين 4: با اس��تفاده از پنل Color Mixer، رنگي با مدل RGB بسازيد که درصد 
رنگ آن مطابق شکل 8-7 باشد. 

شکل 7-8

Swatches 2-2-7 اضافه کردن رنگ به پنل

در پايي��ن پنل Mixer، دکم��ه Add to swatches قرار دارد که با کليک روي آن مي‌توانيد 
رنگ س��اخته ش��ده را به پنل Swatches اضافه کنيد يا روي رنگ ساخته شده کليک راست 
 Add to Swatches را انتخاب کنيد در اين صورت کادر محاوره Add to swatches کرده و گزينه
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مطابق شکل 9-7 ظاهر مي‌شود.
در کادر محاوره Add to Swatches شماره‌هاي رنگ انتخابي و نمونه رنگ آن نمايش داده 

مي‌شوند که مي‌توانيد شماره را پاک کرده و نامي براي اين رنگ انتخاب کنيد.

Add to Swatches شکل 9-7 کادرمحاوره

هم چنين نوع رنگ را مي‌توانيد از بين دو گزينه Process )رنگ‌هاي پردازشي يا ترکيبي( 
 Swatches رنگ موردنظر به پنل ، Add تک رنگ( انتخاب کنيد و با کليک روي دکمه( Spot و

اضافه مي‌شود.

 توجه: مي‌توانيد رنگ ساخته شده را از روي نوار رنگي در پايين پنل Mixer درگ 
کرده و مستقيماً آن را به پنل Swatches اضافه کنيد.

• رنگ‌هايي هس��تند که با استفاده از رنگ‌هاي فيروزه‌اي، ارغواني،  	Process رنگ‌هاي
زرد و سياه ساخته مي‌شوند.

• رنگ‌هايي هستند که با استفاده از رنگ‌ها و جوهرهاي خاصي ساخته  	Spot رنگ‌هاي
مي‌ش��وند. براي روش��ن شدن مطلب مثلًا اگر به رنگ سبز يک مجله چاپ شده نگاه 
کنيد؛ متوجه خواهيد شد که آن رنگ، ترکيبي از رنگ‌هاي فيروزه‌اي و زرد است در 
صورتي که اگر اين رنگ س��بز به صورت نقطه‌اي )Spot( باشد فقط به وسيله جوهر 

خالص سبز ايجاد مي‌شود.
رنگ‌هاي Spot بيش��تر در کاره��اي تک‌رنگ، دورنگ و ايجاد رنگ‌ه��اي ويژه نظير رنگ 

مهتابي و متاليک استفاده مي‌شود. 
تمرين 5: رنگ ايجاد ش��ده در تمرين 4 را ب��ا در نظر گرفتن آن به صورت رنگ 

پردازشی به ليست رنگ‌هاي پنل Swatches اضافه کنيد.
)Change Attribute Color( 3-7 تغيير خصوصيت رنگ‌ها

اگر خصوصيات رنگ‌هايي که در رنگ‌آميزي موضوعات از آن استفاده کرده‌ايد، تغيير داده 
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ش��ود؛ اين تغييرات در رنگ موضوعات هم اثر خواهد گذاش��ت. در پنل Color Mixer دکمه
Change Attribute Color اي��ن امکان را فراهم مي‌کند که بتوانيد خصوصيت رنگ‌ها را تغيير 

بدهيد )شکل 7-10(.	

Color Mixer در پنل Change Attribute Color شکل 10-7 دکمه

 مثال 1: خصوصيت رنگ شکل 11-7 را با استفاده از پنل Color Mixer به رنگي 
که ايجاد کرده‌ايد، تغيير دهيد.

 Color Mixer در پنل  C :34 و M :27 ، Y :0 ، K :0 و مش��خصات CMYK 1- رنگي با مدل
ايجاد کنيد.

2- شکل 11-7 را رسم کنيد.

 شکل 7-11

3- ش��کل را ب��ا رنگ م��دل RGB که مش��خصات آن G:200 ، B:255 و R:255 اس��ت، 
رنگ‌آميزي کنيد.

4- روي دکم��ه  Change Attribute Colorکلي��ک کنيد تا خصوصيت رنگ RGB به رنگ 
CMYK  تبديل شود.

تمرين 6: چرخه رنگ را با مد CMYK ايجاد كنيد )با طراحي دلخواه(.
 )Tints( 4-7 ايجاد تناليته‌هاي رنگ

 Window→Tints واقع ش��ده که مي‌ت��وان آن را از طريق Mixer اي��ن پنل در کنار پنل
روي صفح��ه ظاه��ر کرد. اين پنل، تناليته يا ته رنگ‌هايي با درصدهاي 10% تا 90% از رنگ 
اصل��ي را ارائ��ه مي‌دهد و امکان انتخاب و افزودن آن‌ها را به پنل Swatches براي کاربر فراهم 
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مي‌سازد )شکل 7-12(.

Tints شکل 12-7 پنل
ب��ه عن��وان مثال فرض کنيد ي��ک رنگ نارنجي ب��ا ترکيب 45% ارغوان��ي و 100% زرد 
ساخته‌ايد اما مي‌خواهيد اين رنگ را با نسبت‌هاي‌کمتري از آن در صفحه امتحان کنيد. اين 
امر در پنل Color Mixer مستلزم صرف وقت زيادي است، درحالي که در پنل Tints مي‌توانيد 

نسبت‌هاي متفاوتي از يک رنگ را در صفحه امتحان و رنگ دلخواه را انتخاب کنيد.
1-4-7 روش ايجاد ته‌رنگ )تناليته( يک رنگ 

1- رنگ دلخواهي را در Color Mixer ايجاد کنيد.
2- در پنل Tints درصد ته‌رنگ را با يکي از روش‌هاي زير انتخاب کنيد:

• تنظيم درصد رنگ با استفاده از دکمه لغزنده ته‌رنگ	
• تايپ درصد مورد نظر در کادر ته‌رنگ 	
• کليک روي يکي از نمونه‌هاي ته‌رنگ 	

3- پ��س از ايجاد ته‌رنگ‌ها مي‌توانيد آن‌ها را در پن��ل Swatches ذخيره کنيد. مي‌توانيد 
از طريق دکمه Add to Swatches در پنل Tints يا از طريق منوي بازش��وي رنگ‌ها و انتخاب 

گزينه Add to Swatches رنگ را به پنل Swatches اضافه کنيد.

 توج�ه: هنگامي ک��ه رنگي را به پنل Swatches مي‌افزاييد ي��ا به عبارتي آن را به 
مجموعه رنگ‌هاي FreeHand اضافه مي‌کنيد؛ اين رنگ در منوي رنگ‌ها در پنل Tints قابل 

دسترسي است.

 G:152 ،B:189 از رنگي با مشخصات Color1 مثال 2: ته رنگ 40 درصدي به نام
و R:243 ساخته و ذخيره کنيد.
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براي ايجاد اين رنگ مراحل زير را انجام دهيد:
1- ابتدا پنل Color Mixer را باز کرده و دکمه RGB را انتخاب کنيد.

2- عددهاي رنگ را در کادرهاي مربوطه وارد کنيد.
3- زبان��ه Tints رابرگزيده و 40% را درکادرته‌رنگ واردکني��د يا روي‌نمونه40% ته‌رنگ، 

کليک کنيد.
4- روي دکمه  Add to Swatches در پنل Tints کليک کنيد.

5- در کادر مح��اوره  Add to Swatches ش��ماره رنگ را پاک ک��رده و نام Color1 را وارد 
کنيد؛ س��پس دکم��ه Add را کليک کنيد. در اي��ن صورت رنگ در پن��ل Swatches ذخيره 

مي‌شود.
تمرين 7: عمليات زير را انجام دهيد:

 Color رسم کرده و با استفاده از پنل paint1 به نام ،A4 1- شکل 14-7 را در يک صفحه
Mixer و Tints رنگ‌آميزي کنيد.

2- رنگي با مشخصات M : 70 ،Y : 80 ،K : 0 و C : 2 ايجاد کنيد، سپس آن را به ليست 
رنگ‌ها اضافه کنيد.

3- رنگي با مش��خصات G :200 ، ‌B : 8 و R : 16 ايجاد کنيد، س��پس ته‌رنگ‌هايي از اين 
رنگ با درصدهاي 80، 60 و 10 ايجاد کنيد و به ليست رنگ‌ها بيفزاييد.

4- رنگي با مش��خصات G: 90 ،B: 50 و R: 155 تعريف کنيد، س��پس غلظت آن را %80 
و روشنايي آن را نيز به 75% تغيير دهيد.

شکل 7-13

تمرين 8: طيف رنگ يا تناليته‌‌هاي مختلف رنگ آبي را ترسيم كنيد.

شکل 14-7 تناليته‌هاي رنگ آبي



Free Hand پیمانه مهارتی : کاربر
167واحد کار هفتم: توانایی کار با رنگ و ویرایش آن 

 Swatches 5-7 پنل
 Swatches پنل ،FreeHand MXa يکي از پرکاربردترين پنل‌ها، براي رنگ‌آميزي اشکال در

است )شکل 7-15(. 

Swatches شکل 15-7 پنل

پس از تعريف يک رنگ در Color Mixer براي استفاده مجدد آن در رنگ‌آميزي طرح‌هاي 
ديگر، بايد آن را درSwatches  ذخيره کرد.

از طريق يکي از روش‌هاي ذکر شده در بخش 2-7، پنلSwatches  باز مي‌شود. 
در اين پنل فهرس��تي از رنگ‌هاي س��اخته ش��ده و رنگ‌هاي مورد استفاده در سند، قرار 
گرفته است. يکي از رنگ‌هاي پيش‌فرض در پنل Swatches رنگ Registration ناميده مي‌شود. 
اين رنگ طوري تعريف ش��ده اس��ت که در تمام صفحات، چاپ خواهد ش��د و براي يک کار 
هنري معمولي نبايد از اين رنگ اس��تفاده ش��ود زيرا در چاپ، جوهر زيادي مصرف مي‌کند. 
معمولاً رنگ Registration به صورت سياه نشان داده مي‌شود ولي مي‌توانيد رنگ آن را تغيير 

دهيد. يکي از کاربردهاي اين رنگ، علامت‌گذاري براي برش زدن )Trim( صفحات است.

 توج�ه: براي تغيير رنگ موضوعات و ني��ز رنگ‌آميزي موضوعات جديد مي‌توانيد 
بدون س��اختن دوباره آن‌ها در Color Mixer از نمونه‌هاي موجود در پنل Swatches اس��تفاده 

کنيد.

 Swatches 1-5-7 رنگ‌آميزي به وسيله پنل

1- شکل مورد نظر را ترسيم کرده و آن را به حالت انتخاب در‌آوريد.
2- پنل Swatches را باز کنيد.

3- از رنگ‌هاي ليست شده در اين پنل )Color List(، رنگ موردنظرتان را انتخاب کرده و 
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آن را به روي شکل درگ کنيد يا رنگ را درگ کرده و روي دکمه نشان داده شده در شکل 
15-7 رها کنيد تا داخل موضوع رنگ‌آميزي شود.

 نكته:ب��ا نگ��ه داش��تن کلي��د Alt و کلي��ک روي رن��گ م��ورد نظر در ليس��ت 
 رن��گ پن��ل Swatches جزيي��ات رن��گ به ص��ورت CMYK ي��ا RGB نمايش داده مي‌ش��ود 

)شکل 7-16(.

Swatches شکل 16-7 نمايش جزييات رنگ در پنل

تمرين 9: رنگي با مشخصــات G : 195 ،B : 140 و R : 243 با استفـاده از پنـل 
Color Mixer  ايجاد کرده، سپس آن را به نام Color2 به ليست رنگ‌هاي Swatches اضافه 

کنيد، ترتيبي دهيد که جزييات رنگ نمايش داده شود.
2-5-7 اعمال رنگ )خط - پرکننده( به موضوع 

عملکرد دکمه‌هاي بالاي پنل Swatches به شرح زير است:
• اين گزينه براي رنگ‌آمي��زي داخل موضوع به‌کار مي‌رود که روش  	:  Fill دکم�ه

ديگر استفاده از آن به صورت زير است: 
1- ابتدا موضوع را انتخاب کنيد سپس روي دكمه Fill كليك كنيد.

2- روي يکي از نمونه رنگ‌هاي موجود در ليست Swatches کليک کنيد تا رنگ انتخاب 
ش��ده، داخل شکل قرار گيرد. انتخاب گزينه None از ليست رنگ‌هاي Swatches، رنگ داخل 

شکل را خالي مي‌کند.
آميزي خطوط دور موضوع اس��تفاده  • دکم�ه Stroke  : از اي��ن گزينه ب��راي رنگ‌	
مي‌ش��ود و روش‌هاي اس��تفاده از آن مانند دکمه Fill است. انتخاب گزينه None از 
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ليست رنگ‌ها، خط دور موضوع را محو مي‌کند.
• را به داخل  	Swatches رنگ انتخاب ش��ده از ليس��ت پنل :   Fill & Stroke دکمه
مسير انتخاب شده و هم به خط دور موضوع مي‌دهد. انتخاب گزينه None از ليست 

رنگ‌ها منجر به‌محوکامل موضوع‌مي‌شود اما مسير هم‌چنان قابل انتخاب است. 
 • 	 Swatchesدکمه تکثير رنگ  : براي کپي از يک رنگ کافي اس��ت، رنگ را از پنل

به سمت اين دکمه درگ کنيد.
تمرين 10: ش��کل‌هاي 17-7 و 18-7 را رس��م کرده و رنگ‌هاي داده ش��ده را با 
استفاده از پنل Color Mixer ايجاد کرده و به وسيله پنل Swatches به خط دور شِکل 7-17 
رنگ 1، به داخل شکل 17-7 رنگ 2 و به دور و داخل شکل 18-7 رنگ 3 را اعمال کنيد. 

رنگ 1: مدل RGB، رنگ سفيد
 RGBرنگ2: مدل

CMYK رنگ3: مدل

              
CMYK شکل 18-7  مدل                                   RGB شکل 17-7  مدل          

3-5-7 ايجاد، حذف، جابه‌جايی و کپی کردن رنگ

با استفاده از فرمان‌هاي منوي کنترل در پنل Swatches مي‌توانيد رنگ جديدي به ليست 
اضاف��ه کرده و از رنگ‌هاي موجود نس��خه کپي تهيه کرده، رنگ را از ليس��ت حذف يا رنگ 
ديگ��ري را جايگزي��ن آن کنيد. با کليک روي منوي کنت��رل  در پنل Swatches، منويي 
ظاهر مي‌ش��ود که حاوي تعدادي فرمان و يك س��ري مجموعه رنگ )آلبوم رنگ( است، اين 

فرمان‌ها عبارتند از:
کند. • New: رنگ ساخته شده در پنل Color Mixer را به پنل Swatches اضافه مي‌	

• به کار  	Swatches ب��راي تهيه کپي و تکثير رنگ انتخاب ش��ده در پن��ل :Duplicate

مي‌رود.
• Remove: انتخاب اين گزينه باعث حذف رنگ انتخابي از پنل Swatches مي‌شود.	

• اين گزينه، رنگ انتخاب ش��ده را جايگزين يکي از نمونه رنگ‌هاي موجود  	:Replace
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در ليست رنگ‌‌هاي Swatches مي‌کند.
روش اجراي جايگزيني رنگ 

1- از ليست پنل Swatches ، رنگي را که مي‌خواهيد جايگزين کنيد، برگزينيد.
2- از من��وي کنترل��ي پنل Swatches گزين��ه Replace را انتخاب کنيد ت��ا کادر محاوره

Replace Color  باز شود.

3- از منوي بازش��وي Color  library )کتابخانه رنگ( يک مجموعه رنگ را انتخاب کرده 
و از داخ��ل آن رنگ مورد نظر را برگزينيد يا از منوي بازش��وي Color List رنگ مورد نظر را 

انتخاب کنيد تا عمل جايگزيني انجام گيرد.
4-5-7 پنهان و آشکار کردن نام رنگ

 Show/Hide گزينه ،Swatches براي آشکار و مخفي کردن نام رنگ‌ها در ليست رنگ‌هاي
names که از طريق منوي کنترل آن قابل دسترس است به‌کار مي‌رود )شکل 7-19(.

Swatches شکل 19-7 پنهان کردن نام رنگ در پنل

تغييرنام رنگ 
براي تغيير نام نمونه رنگ انتخاب شده در پنل Swatches، روي نام رنگ دابل کليک کنيد 

تا علامت چشمک‌زن مکان‌نما ظاهر شود و نام جديد را تايپ کنيد.
تمرين 11: ش��کل 20-7 را رسم کرده آن را با رنگ سفيد مدل RGB رنگ‌آميزي 
کني��د و ترتيب��ي دهيد که رنگ G:152 ،B :189 و R:243 که ب��ا نام color1 در مثال 2 ايجاد 

کرده‌ايد، جايگزين آن شود و نام رنگ را تغيير داده و Color3  بگذاريد.

شکل 7-20
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5-5-7 تبديل رنگ‌هاي CMYK و RGB به يکديگر	

 Make RGB و Make CMYK و بالعکس فرمان‌ه��اي RGB به CMYK ب��راي تبدي��ل رنگ
به‌کار مي‌روند که در منوي کنترلي پنل Swatches قرار دارند.

• Make CMYK: براي تبديل رنگ‌هايRGB  به رنگ‌هاي CMYK به‌کار مي‌رود.	

• به‌کار مي‌رود که به‌صورت  	RGB به  CMYKبه‌منظور تبدي��ل رنگ‌هاي :Make RGB

 ديده مي‌شود.
 CMYK را ک��ه در تمرين 11 ايجاد کرده‌اي��د به مدل Color3 تمري�ن 12: رنگ

تبديل کرده و نام آن را Color4 بگذاريد.
	Process و Spot 6-5-7 ايجاد رنگ‌هاي

 Add و دکمه Color Mixer همان‌طور که در بخش 1-2-7 گفته ش��د با اس��تفاده از پنل
 Swatches مي‌توانيد رنگ پردازش��ي و نقطه‌اي بس��ازيد. در منوي کنترلي پنل to swatches

فرمان‌هاي تبديل رنگ پردازشي و نقطه‌اي قراردارد که عبارتند از:
• را به رنگ  	 Swatchesانتخاب ش��ده در پن��ل )Process( رنگ پردازش��ي :Make spot

نقطه‌اي )Spot( تبديل مي‌کند.
• را  	Swatches انتخاب اين گزينه، رنگ نقطه‌اي انتخاب ش��ده در پنل :Make process

به رنگ پردازشي تبديل مي‌کند.

 نكته: رنگ‌هايي که با اس��تفاده از RGB يا HLS تعريف شده‌اند، يک آيکن سه 
رنگ کوچک  در سمت راست نام آن‌ها قرار دارد )شکل 7-21(. 

شكل 7-21

در ش��کل 21-7 از بالا به پايين: رنگ پردازش��ي CMYK، رن��گ نقطه‌اي CMYK، رنگ 
.RGB رنگ نقطه‌اي  ،RGB پردازشي

 توجه: اس��امي رنگ‌هاي پردازش��ي در پنل Swatches  به صورت ايتاليک مشاهده 
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مي‌شوند و رنگ‌هاي Spot  به صورت معمولي نشان داده مي‌شوند.

تمرين 13: رنگ Color4 را که در تمرين ايجاد کرده‌ايد، به رنگ نقطه‌اي تبديل 
کنيد.

6-7 آشنايي با انواع پالت‌هاي رنگ 

در برنام��ه FreeHand ب��راي رنگ‌آمي��زي موضوعات، علاوه بر پالت رنگ سيس��تم عامل 
Windows، پالت‌ه��اي متعددي وجود دارد مانن��د Web Safe 216 که 216 رنگ در مجموعه 

رنگ آن وجود دارد و در مجموعه رنگ‌هاي کتابخانه رنگ با نام Web Safe Color قراردارد؛ نام 
تعدادي از پالت‌ها که در زمان صادر کردن تصوير با فرمت Gif تنظيمات آن قابل دسترس��ي 

است، در ادامه نشان داده شده است.
WebSafe 216 -2 			  Exact Palette -1       

Color 64 -4	WebSnap Adaptive 256, 128, 16 -3       
Color 16 -6 			  Color 32 -5       

Grays -7       
• را  	Swatches امکان اضافه کردن بيش از يک پالت به پنل ،Wizard بعضي تنظيمات

فراهم مي‌کند.
Library 7-7 استفاده از جدول رنگ‌هاي فتوشاپ و رنگ‌هاي

FreeHand MXa به‌‌طور پيش‌فرض داراي مجموعه رنگ‌هاي )Library Color( متعددي از 

جمله رنگ‌هاي آماده  PANTONE است که مي‌توانيد رنگ مورد نظر را انتخاب کرده و آن را 
به رنگ‌هاي Swatches اضافه کنيد. اين رنگ‌ها از نوع Coated و UnCoated اس��ت. به عبارت 
ديگر اين گونه رنگ‌هاي آماده و استاندارد، مخصوص چاپ روي کاغذهاي بدون پوشش براق 

)UnCoated( يا پوشش‌دار براق )Coated( است.

 توجه:ب��راي انتخاب چند رنگ از مجموعه رنگي ي��ا آلبوم رنگ مي‌توانيد با کليد 
Shift رنگ‌هاي متوالي و کليد Ctrl رنگ‌هاي مجزا از هم را انتخاب کنيد )شکل 7-22(.
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شکل Library 7-22 يا مجموعه رنگ

اگر بخواهيد از جدول رنگ فتوشاپ استفاده کنيد، به طريق زير عمل کنيد:
1- مسير Xtras→Colors→Import RGB Color Table را اجرا کنيد.

2- در کادر محاوره Open فايل ACT فتوش��اپ )جدول رنگ مورد نظر( را مشخص کرده 
و رنگ‌هاي آن را به پنل Swatches وارد کنيد.

 توجه:دربعضي‌از نسخه‌هاي‌فتوش��اپ محل ذخيره‌س��ازي جدول رنگ در پوش��ه 
Presets\Optimized Colors يا Presets\Save for Web Settings  است.

توانيد  • با فرمان Import RGB Color Table علاوه بر استفاده از جدول رنگ فتوشاپ مي‌	
يك مجموعه رنگ ذخيره شده پوشه Palettes واقع در برنامه FreeHand را به ليست 

رنگ‌‌هاي موجود در پنل Swatches اضافه کنيد. 

 نكته: پسوند فايل‌هاي جدول رنگ فتوشاپ Act است.

1-7-7 اضافه کردن و صادر کردن رنگ 

ازديگرفرمان‌ه��اي منوي کنترل در پنل Swatches، فرمان Import وExport اس��ت که به 
شرح زير هستند:

 • Import: به منظور فراخواني ليس��ت ذخيره ش��ده در پنل Swatches به‌کار مي‌رود،	

همچنين با اس��تفاده از اين فرم��ان مي‌توان رنگ‌هاي آم��اده )مجموعه رنگ( مثل 
رنگ‌هاي PANTONE  را به پنل Swatches اضافه کرد.
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• اگ��ر بخواهيد دقيقاً رنگ‌هايي را که در طراحي اس��تفاده کرده‌ايد و به پنل  	:Export

Swatches افزوديد در سند ديگري نيز استفاده کنيد، مي‌توانيد ليست رنگ را با اين 

فرمان ذخيره کرده و با فرمان Import آن‌ها را بازيابي کنيد. به عبارت ديگر با فرمان 
Export مي‌تواني��د يک آلبوم رنگ يا کتابخانه‌اي از رنگ‌هاي سفارش��ي ايجاد کنيد 

)شكل 7-23(.

شکل 23-7 کادر ساختن آلبومي از رنگ‌ها

تمري�ن 14: آلبوم رنگي ب��ا نام Class-Color و نام فايل دلخ��واه ايجاد كنيد كه 
حاوي 2 رنگ س��بز و صورتي از نوع RGB و  3 رنگ آبي و زرد و بنفش از نوع CMYK و يك 

رنگ نارنجي از نوع رنگ‌هاي آماده ويندوز باشد.
 Swatches8-7 مديريت ليست رنگ‌ها در پنل

در برنامه FreeHand مي‌توانيد به صورت زير، مديريت رنگ‌ها را انجام دهيد:
•مرتب کردن رنگ‌ها بر اساس نام آن‌ها 	

•پنهان و آشکار کردن نام رنگ 	
•حذف رنگ‌هايي که در طرح آماده چاپ استفاده نمي‌شود. 	

بعضي از اين کارها در بخش 2-7 گفته شده است، در ادامه به نحوه مرتب‌سازي رنگ‌ها 
بر اساس نام و حذف رنگ‌هايي که در طرح آماده چاپ استفاده نمي‌شود، مي‌پردازيم.

Sort Color List By Name فرمان
براي اجراي فرمان به طريق زير عمل مي‌شود:

• را اجرا کنيد. 	Xtras→Colors→Sort Color List by Name مسير
با استفاده از اين فرمان رنگ‌هاي پنل Swatches برحسب نام مرتب مي‌شوند. 

Unused Named Colors  فرمان
براي اجراي فرمان به طريق زير عمل مي‌شود:
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1- بررسی کنيد موضوعي در وضعيت انتخاب نباشد.
2- رنگ يا رنگ‌هاي مورد نظر را انتخاب کنيد.

3- مسيرXtras→Delete→Unused Named Colors  را اجرا کنيد.
با استفاده از اين فرمان رنگ‌هاي پنل Swatches که در طرح ترسيم شده استفاده نشده‌اند، 

از فهرست رنگ‌ها حذف مي‌شوند.
  Stroke & Fill Color 7-9

هر شئ از يک خط دور )Stroke( و پرکننده درون شئ  )Fill( تشکيل شده است.
رنگ‌آميزي خط دور و درون موضوع ترسيمي

مي‌تواني��د  • 	 Swatches و Tint ،Color Mixer ب��ا اس��تفاده از درگ رن��گ از پنل‌ه��اي
پرکننده درون شئ )Fill( و خط دور )Stroke( موضوع‌هاي ترسيم شده را رنگ‌آميزي 

کنيد )شکل 7-24(.

 

Mixer و Tint ،Swatches شکل 24-7 رنگ‌آميزي موضوع ترسيمي با استفاده از پنل

( نيز امکان  • پن��ل Object و منوي بازش��وي پالت رنگ  در جعبه ابزار )شك��ل 7-25	
رنگ‌آميزي را فراهم مي‌کنند.

شکل 25-7 رنگ‌آميزي موضوع ترسيمي با استفاده از پالت رنگ در جعبه ابزار

در پن��ل Object )شك��ل 26-7( ب��راي رنگ‌آمي��زي داخ��ل و پيرامون ش��ئ ترس��يمي 
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مي‌توانيد:
1- روي دکمه Add Fill براي رنگ‌آميزي داخل موضوع ترس��يمي و دكمه Add Stroke براي 

رنگ پيرامون موضوع ترسيمي کليک کنيد.
2- گزينه Basic را برگزينيد، با کليک روي کادر رنگي پايين پنل Object، رنگ مورد نظر خود 

را انتخاب کنيد.

Object در پنل Fill شکل 26-7 گزينه‌هاي

 توجه: درگ ابزار قطره‌چکان و برداش��تن رنگ از يک ش��ئ به ش��ئ ديگر س��بب 
رنگ‌آميزي موضوعات ترسيمي مي‌شود.

 Color Mixer حرفه‌اي‌ترين روش رنگ‌آميزي به اين صورت است که رنگ ساخته شده در
ي��ا Tints را به پنل Swatches اضافه کنيد، س��پس نمونه رن��گ موردنظر را از درون اين پنل 
به موضوع انتخاب ش��ده نسبت دهيد. اين روش به شما اجازه مي‌دهد که هميشه بر رنگ‌ها 
کنترل داشته باشيد و هرگونه تغيير در خصوصيات رنگ‌ها منجر به ايجاد همان تغييرات در 

رنگ‌هاي موضوعات خواهد شد.

تمرين 15: پرچم ايران را ترسيم و رنگ‌آميزي كنيد.

تمرين 16: 
1- طرح يك منظره ساده را رسم كرده و رنگ‌آميزي نماييد.
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2- رنگ‌هاي سبز را با استفاده از فرمان Replace به رنگ زرد تغيير دهيد.
10-7 اصول ويرايش رنگ

در برنام��ه FreeHand مي‌توانيد رنگ‌هاي کار آماده چاپ را با روش‌هاي مختلف ويرايش 
کنيد. روشن و تيره کردن رنگ‌ها، اضافه و کم کردن درصد ميزان رنگ، ايجاد جلوه خاکستري 
و تک رنگ، تبديل رنگ‌ها به طيف خاکستري و تغيير رنگ‌ها در طرح و اثر آماده چاپ شما 

از موارد ويرايش رنگ است.
1-10-7 کنترل مقدار رنگ 

با استفاده ازColor Control  مقدار درصد رنگ‌ها در مدل‌هاي RGB،CMYK  و HLS کم يا 
زياد مي‌ش��ـود و نام اصـلي رنگي که تغييـر يافتـه در پنـل Swatches باقي مي‌مـاند. گزينـه

Color Control  براي کنترل دقيق رنگ‌ها به‌کار مي‌رود.

 نكت�ه: اگ��ر بخواهيد رنگ تغيير يافته ب��ا Color Control در پنل Swatches قرار 
گيرد، بايد براي آن نامي در نظر بگيريد.

Color Control شکل 27-7 تغيير رنگ شئ با استفاده از

Color Control روش استفاده از
براي استفاده از Color Control به ترتيب زير عمل کنيد:

1- شئ گرافيکی را انتخاب کنيد.
 Color Control را اجراکني��د تا كادرمحاوره Xtras→Colors→Color Control 2- مس��ير

باز شود.
3- يکي از مدل‌هاي رنگ CMYK ، RGB يا HLS را برگزينيد.
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4- براي مشاهده تغييراتي که در رنگ ايجاد مي‌کنيد؛ Preview را انتخاب کنيد.
5- ب��راي تغييرميزان‌رنگ، دكمه ‌لغزنده مربوط ‌به آن را درگ کرده يا عددهاي ‌موردنظر 

را وارد کنيد.
6- براي اعمال تغييرات روي OK کليک کنيد.

- است. • محدوده مورد نظر براي مدل‌هاي رنگ بين 100%+ تا %100	
- است. • ميزان Hue: از360%+ تا %360	

• اس��ت که نشان دهنده عدم  پيش‌فرض موارد تش��کيل‌دهنده مدل‌هاي رنگ عدد 0	
تغيير در رنگ است.

             	

CMYK شكل 29-7 تنظيم رنگ در حالت 		                  شکل 28-7 انتخاب شكل

س��ه حالت رنگ در كادر محاوره Color Control وج��ود دارد كه مي‌توانيد از آن‌ها براي 
تنظيم رنگ‌ها استفاده كنيد )شكل 7-29(.

 نكت�ه: مي‌تواني��د رنگ را در يك حالت تعري��ف و در حالت ديگري آن را تنظيم 
كنيد.

با توجه به اين که رنگ‌هاي قرمز، سبز و آبي از سيستم RGB و آبي Cyan، ارغواني، زرد 
و س��ياه از سيس��تم CMYK دوبه‌دو مکمل يکديگر هستند، براي کم يا زياد کردن يک رنگ 
مي‌ت��وان رن��گ مکمل آن را کم يا زياد کرد. به طور مثال ب��راي کم کردن رنگ آبي در يک 
شکل مي‌توان به مقدار رنگ زرد که رنگ مکمل آن در چرخه رنگ است، اضافه کرد يا براي 
زياد کردن رنگ س��بز در تصوير مي‌توان از ميزان رنگ ارغواني که مکمل آن اس��ت کم کرد. 

اعداد مثبت به مقدار رنگ اضافه ميك‌ند و اعداد منفي رنگ را كاهش مي‌دهد.
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مثال 3: شكل 30-7 را رسم كرده و آن را به دلخواه رنگ كنيد.

شكل 7-30

1- ميزان اشباع رنگ را كم كرده و روشنايي شكل را افزايش دهيد. 
2- براي  اين كار  بايد  فرمانXtras→Colors→ Color Control  را اجرا كنيد. در كادرمحاوره 
Color Control زبانه HLS را انتخاب كرده س��پس با تنظيم دکمه لغزنده مربوط به S ميزان 

 اش��باع رنگ را ��كم و با تنظيم دکمه لغزنده مربوط به L روش��نايي شك��ل را افزايش دهيد‌ 
)شكل 7-31(.

HLS شكل 31-7 تنظيم رنگ در حالت

تمرين 17: شك��ل 32-7 را رس��م كرده و آن را رنگ‌آميزي كنيد؛ با استفاده از 
Color Control رنگ آن را تغيير دهيد.
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شكل 7-32

2-10-7 تبديل رنگ شئ به خاکستري 

براي تبديل رنگ موضوعات به خاكستري از فرمان: 
Xtras→Colors→Convert to Grayscale استفاده كنيد.

روش تبديل رنگ به خاكستري
1- موضوع يا موضوعات مورد نظر را انتخاب كنيد.

2- مس��ير Xtras→Colors→Convert  to Grayscale را اجرا كنيد. رنگ شكل خاكستري 
مي‌شود.

    	  	        

Grayscale شكل 34-7 نتيجه حاصل از تأثير فرمان     	شكل 33-7 انتخاب موضوع گرافيكي

 تمرين 18: شك��ل 34-7 را رس��م و به دلخواه رنگ‌آميزي كنيد، سپس رنگ آن 
‌را خاکستري کنيد.

شكل 7-35
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3-10-7 تيره و روشن کردن رنگ 

با استفاده از گزينه Colors در منوي Xtras مي‌توانيد مقدار رنگ را با هر بار اعمال فرمان، 
يک درجه تيره يا روشن کنيد. 

 نكت�ه: م��وارد Saturate، Darken، Lighten وDesaturate به رنگ‌هاي spot اعمال 
نمي‌شود.

روش اجرا:
1- ابتدا شئ را انتخاب کنيد.

2- مس��ير Xtras→Colors را انتخاب ک��رده و يکي از موارد زير را با توجه به تغييری که 
مي‌خواهيد در رنگ ايجاد کنيد، برگزينيد.

Lighten Colors: رنگ شئ انتخابي را يك درجه روشن‌تر مي‌کند.

Darken Colors: به رنگ سياه شئ، اضافه كرده و آن را تيره‌تر مي‌کند.

Saturate Colors: ميزان غلظت رنگ )اشباع رنگ( را افزايش مي‌دهد.

Desaturate Colors: رنگ را تيره و كدر كرده و اشباع آن را کم مي‌کند.

 نكت�ه: م��وارد گفته ش��ده تا زماني اعمال مي‌ش��ود که رنگ، ب��ه بالاترين ميزان 
تأثيرش برسد.

Lighten Colors مثال 4: فرمان
1- موضوع گرافيكي مورد نظر را انتخاب كنيد.

2- فرمان Xtras→Colors→Lighten Colors را اجرا كنيد. با هر بار اجراي اين فرمان رنگ 
شكل يك درجه روشن‌تر مي‌شود.

Darken Colors مثال 5: فرمان
1- موضوع گرافيكي مورد نظر را انتخاب كنيد.
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2- فرمان Xtras→Colors→Darken Colors را اجرا كنيد. با هر بار اجراي اين فرمان رنگ 
شكل يك درجه تيره‌تر خواهد شد.

شكل 7-36

تمرين 19: شكل 37-7 را رسم و به دلخواه رنگ كنيد سپس شكل را دو درجه 
تيره‌تر كنيد.

شكل 7-37

Saturate Colors مثال 6: فرمان 
1- موضوع گرافيكي مورد نظر را انتخاب كنيد.

2- فرم��ان Xtras→Colors→Saturate Colors را اجرا كني��د. با هر بار اجراي اين فرمان 
غلظت رنگ شكل يك درجه بيشتر مي‌شود )شكل 7-37(.

              	                  

Saturate Colors شكل 38-7 انتخاب‌موضوع‌گرافيكي         شكل 39-7 نتيجه‌حاصل‌از‌تأثير‌فرمان

Desaturate Colors مثال 7: فرمان 
1- موضوع گرافيكي را كه مي‌خواهيد اشباع رنگ آن كم شود، انتخاب كنيد.

2- فرمانXtras→Colors→Desaturate Colors  را چند بار اجرا كنيد تا اشباع رنگ شكل، 
كم‌تر شود.
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شكل 40-7 انتخاب موضوع گرافيكي

 نكته: براي ادامه اشباع رنگ يا خارج کردن رنگ‌ها از حالت اشباع در صورت لزوم 
فرمان مزبور را چندبار تکرار کنيد.

 تمرين 20: 
1- رنگينك‌مان را اجرا كنيد.
2- درجه اشباع را كم كنيد.

3- تناليته‌هاي سه رنگ اصلي را تا 10 درجه بسازيد.
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		 واژه‌نامه
Convertتبديل كردن، معکوس کردن

Coatedپوشش براق

Cyanآبي فيروزه‌اي

Darkenتيره‌تر

Desaturateكم كردن اشباع رنگ

Exactدقيق

Grayscaleخاكستري

Magentaارغواني

Mixerمخلوط‌کن

Pickerانتخاب کننده

Presetsتنظيم شده، پيش تنظيمات

Randomizeاتفاقي، تصادفي

Xtrasاضافي

Swatchنمونه

Trimبرش زدن صفحات

خلاصه مطالب
• به ترتيب براي چاپ يا  	HLS و RGB ،CMYK س��ه مدل رن��گ FreeHand در برنامه
کارهاي نمايشي و وب در نظر گرفته شده‌اند. در مدل‌هاي رنگ امکان حذف، اضافه، 

تغيير نام و ويرايش رنگ‌ها وجود دارد.
•دانس��تيد که می توانید رنگ‌هاي کار آماده چاپ را با روش‌‌هاي‌مختلف به‌اين‌ش��رح  	
ويرايش کنيد: 1- روش��ن و تيره ک��ردن رنگ‌ها 2- اضافه و کم کردن درصد ميزان 
رنگ 3- ايجاد جلوه خاکس��تري و تک رنگ 4- تبديل رنگ‌ها به طيف خاکس��تري 

5- تغيير رنگ‌ها در طرح و اثر آماده چاپ
•از ديگر موارد بررس��ي شده در اين واحد کار مديريت ليست رنگ مي‌باشد از جمله:  	
1- مرتب کردن رنگ‌ها بر اساس نامشان 2- پنهان و آشکار کردن نام رنگ 3- حذف 

رنگ‌هايي که در طرح آماده چاپ استفاده نمي‌شود. 
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آزمون نظري
درستي يا نادرستي گزينه هاي زير را تعيين کنيد.

1- پنل Color Mixer براي ساختن رنگ‌هاي ترکيبي مورد نياز به کار مي‌رود. 
2- در مدل RGB، هر يک از رنگ‌ها با عددي بين 0 تا 100 نشان داده مي‌شوند.

3- پنل تناليته ته‌رنگ‌هايي با درصدهاي 10% تا 90% از رنگ اصلي ارائه مي‌دهد. 
4- رنگ‌هاي Spot رنگ‌هايي هس��تند که با اس��تفاده از رنگ‌هاي فيروزه‌اي، ارغواني، زرد 

و سياه ساخته مي‌شوند. 
معادل گزينه هاي سمت‌راست را از ستون سمت‌چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

Replace   .به‌کارمي‌رود Swatches 5- براي تهيه کپي و تکثير رنگ انتخاب شده در پنل
                     Duplicate    .مي‌شود Swatches 6- انتخاب اين گزينه باعث حذف رنگ انتخابي از پنل
7- اين گزينه، رنگ انتخاب ش��ده را جايگزين يکي از نمونه رنگ‌هاي موجود در ليس��ت 
Remove                                                                  .مي‌کند Swatches رنگ‌هاي

گزينه صحيح را انتخاب کنيد.

8- اگ��ر بخواهي��د رنگ موضوع انتخاب ش��ده اش��باع‌تر ش��ود از كدام فرمان اس��تفاده 
ميك‌نيد؟

Saturate Colors -ب 	Desaturate Colors -الف
Lighten Colors -د 		 Darken Colors -ج

9- با استفاده از كدام فرمان مي‌توان رنگ موضوع انتخاب شده را تيره‌تر كرد؟
	 Darken Colors -ب 	 Convert to Grayscale -الف

 Desaturate Colors -د 	 	 Lighten Colors  -ج
10- کدام‌يک از گزينه‌هاي زير، از موارد ويرايش رنگ نيست؟

Color Control  -ب 	Desaturate Colors  -الف
Websafe 216  -د 		 Lighten Colors  -ج

11- کدام دکمه در پنل Swatches، رنگ انتخاب ش��ده از ليست پنل Swatches را هم به 
داخل مسير انتخاب شده و هم به خط دور موضوع مي‌دهد؟

الف-                  ب-                  ج-                     د-  
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 Swatches 12- با نگه داشتن کليد ......... و کليک روي رنگ موردنظر در ليست رنگ پنل
جزييات رنگ به صورت CMYK يا RGB نمايش داده مي‌شود. 

Alt+Shift -د               Ctrl -ج                Alt  -ب               Shift -الف
13- رنگ پايه، اشباع رنگ و ميزان روشنايي رنگ، در اين حالت رنگ تنظيم مي‌شود.

CMYK  و HLS  -د               HLS  -ج           RGB  -ب            CMYK  -الف
14-  براي آشکار و مخفي کردن نام رنگ‌ها در ليست ‌رنگ‌هاي Swatches، از اين گزينه‌ 

استفاده مي‌شود.
 Restore-ب                   Remove Color -الف

Show color -د 	  Show/Hide names  -ج

در جاي خالي عبارت مناسب را بنويسيد.

15- در مدل ........... تمامي رنگ‌ها از تركيب چهار رنگ اصلي ساخته مي‌شوند.
16- به رنگ‌هاي از نوع CMYK رنگ‌هاي .......... نيز مي‌گويند.

17- فرمان ....................... تمام رنگ‌هاي اس��تفاده ش��ده در س��ند را كه داراي هيچ نامي 
نيستند، به پنل Swatches اضافه كرده و به آن‌ها يك نام اختصاص مي‌دهد. 

18-  ميزان Hue ........ تا .......... است. 
19- رنگ‌ه��اي Spot بيش��تر در کاره��اي ................. و ................... و ايجاد رنگ‌هاي ويژه 

نظير رنگ مهتابي و متاليک استفاده مي‌شود.
 

به سؤالات زير پاسخ تشريحی دهيد.

20- چه مواقعي از گزينه Lighten Colors استفاده مي‌شود؟
21- رنگ‌هاي مکمل سيستم RGB و CMYK را نام ببريد.

22- کدام مدل رنگ بر اس��اس جوهرهاي چاپ که روي کاغذ س��فيد جذب مي‌ش��وند، 
ساخته مي‌شود؟

23- رنگ‌هاي Spot و Process چه تفاوتي با يكديگر دارند؟
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آزمون عملي
1- پوس��تري به مناسبت برپايي نمايشگاه كتاب طراحي كنيد كه شكل روبه‌رو به عنوان 

آرم اين پوستر باشد.

2- شكل زير را رسم و رنگ‌آميزي كنيد سپس رنگ‌هاي به‌کار رفته در تصوير را به پالت 
Swatches اضافه کنيد و فرمان Randomize Named Color را روي آن اجرا کنيد.

3- شکل‌هاي زير را رسم و با استفاده از پالت‌هاي رنگ آن‌ها را رنگ‌آميزي کنيد.

             

4- شکل‌هاي بعد را رسم کرده و رنگ‌هاي آن‌ها را به پالت Swatches اضافه کنيد، سپس 
نام رنگ‌هاي پالت را مرتب و درجه رنگ شکل‌ها را روشن‌تر کنيد.
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5- كارت پستالي به صورت دو برگي و به مناسبت »روز مادر« با ابعاد دلخواه طراحي كنيد.
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كليات
نرم‌افزار FreeHand امکانات مختلفي را براي پرکردن اشکال و طرح‌ها در اختيار شما قرار 

مي‌دهد که اين پرکننده‌ها در جذاب‌تر شدن پروژه‌هاي هنري تأثير به‌سزايي دارند.
همان‌ط��ور ک��ه در واحد كار قبل گفته ش��د از گزين��ه Fill براي پر ک��ردن رنگ داخل 
موضوعات و مس��يرها اس��تفاده مي‌ش��ود. اما علاوه بر رنگ‌ها مي‌ت��وان از طرح‌ها و الگوهاي 
ديگري نيز براي پر کردن داخل موضوعات استفاده کرد. البته رنگ الگوها و طرح‌ها بر اساس 

رنگ انتخاب شده در پنل Swatches تعيين مي‌شود.
Object در پنل Add Fill 1-8 دکمه

در FreeHand MXa خ��واص Fill و Stroke در پن��ل Object ق��رار گرفته‌ان��د و به صورت 
مستقل ديده نمي‌شوند.

Fill زيرمجموعه‌اي از پنل Object اس��ت که با باز ش��دن پنل Object مطابق ش��کل 8-1 

.)Ctrl+F3 روي صفحه ظاهر مي‌شود )کليد ميانبر

Object در پنل Fill  شکل 1-8 گزينه‌هاي

در پنل Object روي دکمه‌اي که ش��بيه س��طل رنگ اس��ت، کليک کنيد تا گزينه‌هاي 
تنظيمي مربوط به رنگ‌هاي داخل موضوعات ظاهر شود.

در اين قسمت تعيين مي‌شود که موضوع موردنظر با يکي از رنگ‌هاي پنل Swatches پر 
شود )حالت Basic( يا از طرح‌ها و الگوهاي ديگري براي پرکردن داخل شکل استفاده شود.

5- كارت پستالي به صورت دو برگي و به مناسبت »روز مادر« با ابعاد دلخواه طراحي كنيد.
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 توجه: فعال بودن گزينه OverPrint سبب مي‌شود که رنگ انتخاب شده با رنگ‌هاي 

زيرين خود ادغام شود، مثلًا اگر رنگ شکل آبي فيروزه‌اي )سايان( باشد و رنگ زمينه آن زرد 
باشد در چاپ، شکل به رنگ سبز چاپ مي‌شود.

Add Fill نحوه استفاده از دکمه
1- ب��ا کليک روي دکمه Add Fill در پنل Object گزينه‌هاي‌تنظيمي مربوط به Fill ظاهر 

مي‌شود.
2- شکل يا متن مورد نظر را انتخاب کنيد.

3- از منوي بازش��وي انواع Fill )پر کننده داخل ش��کل(، يکي از گزينه‌هاي آن را انتخاب 
نماييد.

در اين بخش به شرح گزينه‌هاي منوي بازشوي انواع Fill مي‌پردازيم.
2-8 انواع طرح‌ها

 Basic 8-2-1

اين ‌نوع طرح به‌منظور رنگ‌آميزي يکدست و خالص خط‌دور و محتواي داخل موضوعات 
‌انتخابي به‌کار‌ مي‌رود.

 Basic روش‌هاي اعمال طرح
• اعمال طرح Basic با استفاده از منوي بازشو Fill در پنل Object )شكل 8-2(.	

• كه همان انتخاب ‌رنگ از پالت ‌رنگ 	Tools با استفاده از جعبه ابزار Basic اعمال طرح
Fill  است.

• صورت  	Swatches با اس��تفاده از انتخ��اب رنگي كه از پن��ل  Basic اعم��ال رنگ نوع
مي‌گيرد.

تمرين 1: ش��کل 2-8 را كه چرخه دوازده رنگ پيشنهادي ايتن است ترسيم كرده 
و رنگ‌آميزي نماييد.
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شکل 8-2

 Color مي‌توانيد ب��ا درگ رنگ از پنل‌هاي Fill از انواع Basic نكت�ه: در ص��ورت انتخاب طرح 
Tints ،Mixer يا Swatches به داخل پالت رنگ Fill، شکل را رنگ‌آميزي کنيد.

Gradient 8-2-2

منظور از Gradient، طيف رنگي اس��ت که از يک رنگ ش��روع و به رنگ‌هاي ديگر تبديل 
مي‌شود.

گاهي اوقات براي زيبايي در رنگ‌آميزي ترس��يماتي نظير رنگ‌آميزي آسمان، خورشيد، 
رنگين‌کمان، سايه، افق و موارد ديگر نياز به اين نوع طرح است.

Gradient روش اعمال
1- از من��وي بازش��وي انواع Fill در پن��ل Object، گزين��ه Gradient را برگزينيد. در اين 

صورت گزينه‌هاي تنظيمي آن ظاهر مي‌شود )شکل 8-3(.

 Gradient شکل 3-8  گزينه‌هاي تنظيمي 

2- از منوي بازشوي Gradient type مي‌توانيد انواع شيب‌هاي گراديان را انتخاب کنيد.
Gradient انواع

• به کمک نوار رنگي اين قس��مت مي‌توان انواع رنگ‌ها را به  	:)Linear( ش�يب خطي
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صورت تدريجي و خطي در يکديگر محو کرد همچنين به ش��يب گراديان، زاويه داد 
و بر موضوع انتخابي اعمال کرد )شکل 8-4-1(.

گزينه‌هاي کنترلي اين طيف براي تعيين محل ش��روع )Start(، زاويه دس��تگيره و درصد 
طول گراديان در Handle1  و انتخاب رنگ‌هاي مختلف در طيف به‌کار مي‌رود.                                                    

شكل 8-4-1

 نكته: با اس��تفاده از دستگيره‌هاي Gradient )يک نقطه شروع و يک نقطه پايان( 
روي ش��کل، مي‌توانيد محل ش��روع، زاويه و طول گراديان را به‌طور دستي تنظيم کنيد. اين 

دستگيره‌ها همچنين با نگه داشتن کليد Ctrl     ظاهر مي‌شوند )شكل 8-5-1(.
ج

 توجه: اگر دستگيره‌هاي گراديان را نمي‌بينيد، روي ابزار Subselect يا Pointer دابل كليك كنيد 

و در كادر محاوره باز شده گزينه Show Fill Handles را فعال نماييد.

، رنگ داخل موضوع  • 	Gradient با انتخاب اين نوع :)Radial( شيب کروي يا شعاعي
انتخاب ش��ده از مرکز ش��روع مي‌شود و يک کره ايجاد مي‌کند، اين شيب يک شيب 

مدور است )شکل 8-4-2(.

شكل 8-4-2

اعمال  • 	 Gradient تغيير رنگي که در اين نوع :)Contour( ش�يب انعکاسي يا تابعي
مي‌شود بر اساس شکل مسيري است که انتخاب کرده‌ايد )شکل 8-4-3(.



Free Hand پیمانه مهارتی : کاربر
193واحد کار هشتم: توانایی استفاده از پرکننده ها و فرمان های ویرایش اشیاء

گزينه‌هاي کنترلي مانند طيف‌هاي قبلي اس��ت و گزينه Taper جهت تنظيم ميزان نفوذ 
رنگ‌هاي طيف در يکديگر به كار مي‌رود.

شکل 8-4-3

اين نوع طيف مانند طيف رنگ خطي است با اين  • 	 :)Logarithmic( شيب لگاريتمي
تفاوت که تغيير رنگ‌ها به طور نامساوي صورت مي‌گيرد )شکل 8-4-4(.

اين طيف نيز مانند طيف رنگ شعاعي است، با اين  • 	 :)Rectangle( شيب مستطيلي
تفاوت که طيف از مرکز شروع و يک مستطيل ايجاد مي‌کند )شکل 8-4-5(.

تغيير رنگ در اين طيف به شکل، حالت برجستگي شبيه  • 	 :)Cone( شيب مخروطي
هرم يا يک مخروط سه بعدي مي‌دهد )شکل 8-4-6(.

          

شکل 4-4-8                       شکل 5-4-8                    شکل 8-4-6

1- از منوي بازش��وي Behavior type مي‌توانيد نحوه پرش��دن ش��کل را توس��ط گراديان 
تنظيم کنيد. اين گزينه‌ها عبارتند از: Normal )معمولي(، Repeat )تکرار(، Reflect )انعکاس( 

و Auto Size )اندازه اتوماتيک(.
 2- در کادره��اي Start مي‌تواني��د مختص��ات x و y نقط��ه ش��روع را مش��خص کني��د 

)شکل 8-5(.
3- در کادرهاي Handle مي‌توانيد زاويه گراديان و فاصله بين دورنگ يا طول گراديان را 

به طور دلخواه تنظيم کنيد )شکل 8-5(.
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شکل 5-8 گزينه‌هاي گراديان

4- در پايي��ن پنل Object، يک نوار رنگي وجود دارد که رنگ‌هاي موجود در طيف رنگ 
را نمايش مي‌دهد. به طور پيش‌فرض گراديان‌ها حاوي دو رنگ هس��تند که مي‌توانيد تعداد 

رنگ‌ها را تغيير داده و اضافه کنيد.
در ابت��دا و انتهاي نوار رنگي، دو مرب��ع قرار دارد که نمايانگر رنگ ابتدا و انتهاي گراديان 
اس��ت. براي تغيير رنگ، روي مربع‌ها کليک کنيد تا پالت رنگ باز ش��ده و از داخل آن رنگ 

موردنظر خود را انتخاب کنيد.

 نكت�ه: براي اضافه کردن رنگ مي‌توانيد روي ه��ر کدام از مربع‌ها کليک کرده و 
آن را به س��مت داخل نوار رنگي درگ کنيد و براي حذف يک رنگ، کافي اس��ت مربع را به 

خارج از پنل درگ کنيد.

مثال 1: ش��کل 6-8 را با اس��تفاده از انواع Gradient نشان داده شده، رسم کنيد 
 

)رنگ دلخواه(.

شکل 8-6
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1- از خط‌کش‌ها و Guides براي رسم دقيق استفاده کنيد.
2- ابتدا طراحي و ترسيمات شکل را انجام دهيد.

3- کوه‌ها و دامنه آن را انتخاب کرده و گراديان خطي را به رنگ دلخواه، روي آن اعمال 
کنيد.

4- خورش��يد را به حالت انتخاب درآورده و طيف رنگ ش��عاعي براي آن در نظر بگيريد، 
سپس خط دور آن را حذف کنيد.

5- شعاع‌هاي خورشيد را با گراديان لگاريتمي رنگ کنيد.
6- ام��واج دريا را با گرادي��ان خطي رنگ کنيد. به نوار رنگي، رن��گ اضافه کرده و آن را 

تغيير دهيد.
7- جزيره را انتخاب کرده و گراديان انعکاسي را به آن اعمال کنيد.

8- پايه چتر را با گراديان مستطيلي و سر آن را با گراديان مخروطي رنگ کنيد.
تمرين 2: 

 
1- يك برش پرتقال را با توجه به گراديانت‌ها طراحي كنيد.

2- شكل 7-8 را رسم کرده و با گراديان‌هاي مناسب رنگ کنيد.

شکل 8-7

3- تصويري از پاييز را رسم كرده و با گراديان‌هاي مناسب رنگ‌آميزي كنيد.
Textured 8-2-3

پرکننده Textured تصاوير گرافيکي آماده‌اي هستند که به جاي رنگ دادن به موضوعات 
به آن‌ها نماي بافت مي‌دهند. اين پرکننده‌ها در صفحه مانيتور قابل رؤيت نيستند و تنها در 

کارهاي چاپي مشاهده مي‌شوند.
)بافت( • 	 Textured روش اعمال

1- گزينه Textured را از منوي بازشوي انواع Fill انتخاب کنيد، در اين صورت گزينه‌هاي 
تنظيمي آن ظاهر مي‌شود )شکل 8-8(.
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Fill از انواع Textured شکل 8-8 گزينه

2- از منوي بازش��وي انواع بافت‌ها، بافت موردنظر خود را انتخاب کنيد که در اين حالت 
در پنجره پيش نمايش، بافت انتخابي نشان داده مي‌شود.

3- امکان تغيير رنگ بافت انتخابي نيز در فهرست Color اين گزينه وجود دارد.
4- در ش��کل انتخاب ش��ده به جاي مشاهده بافت، يک سري حرف c مي‌بينيد که شکل 
را پر کرده است )شكل 9-8(. همان‌طور که گفته شد اين پرکننده‌ها در چاپ قابل مشاهده 

هستند.

شکل 9-8 نمايش بافت در صفحه نمايش

 توجه: روش کار با گزينه Custom از انواع Fill نيز مشابه Textured است.
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Pattern 8-2-4

پرکننده‌هاي Pattern، الگوهايي هستند که مي‌توانيد در ترسيمات به جاي رنگ از آن‌ها 
استفاده کنيد. اين الگوها را مي‌توان پيكسل به پيكسل و به سادگي ويرايش نمود تا به صورت 
دلخواه درآيند. الگوهاي اعمال ش��ده به موضوعات بلافاصله توس��ط مانيتور قابل مش��اهده 

هستند.
• 	Pattern روش اعمال

1- موضوع ترسيمي را انتخاب کنيد.
2- گزين��ه Pattern را از منوي بازش��وي انواع Fill برگزيني��د. در اين صورت، گزينه‌هاي 

تنظيمي الگوها ظاهر مي‌شوند )شکل 8-10(.
3- براي مش��اهده و انتخاب Pattern موردنظر از دکمه لغزنده اين کادر محاوره اس��تفاده 
کرده و يک الگو را انتخاب کنيد. با کليک روي هر Pattern مي‌توانيد پيش‌نمايش��ي از آن را 

در کادر سمت چپ دکمه لغزنده کادر محاوره مشاهده کنيد. 
4- در س��مت چ��پ کادر پيش‌نمايش، کادر ويرايش قرار دارد ک��ه با کليک کردن روي 

پيکسل‌ها يا خانه‌هاي آن مي‌توانيد الگوي مورد نظر را ويرايش کنيد.
5- رنگ Pattern را مي‌توانيد از ليست رنگ‌هاي موجود در فهرست Color تغيير دهيد.

 توجه: به منظور طراحي الگوي جديد مي‌توانيد با اس��تفاده از دکمه Clear، الگوي 

پيش‌فرض را پاک کرده و يک صفحه خالي ايجاد کنيد.

شکل 10-8 گزينه‌هاي Pattern و نمونه‌هايي از چند شکل پر شده با الگو
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 توج�ه: دکمه Invert، نقاط يا پيکس��ل‌هاي س��ياه را به س��فيد و بالعکس تبديل 

مي‌کند.

 نكت�ه: موضوعاتي که در پش��ت پرکننده Pattern ق��رار مي‌گيرند، از طريق فضاي 
سفيد Pattern قابل مشاهده نيستند.

 نكته: براي قرار دادن موضوع انتخابي در پش��ت س��اير اشکال، گزينه زير را به‌کار 
ببريد.

Modify→Arrange→Send to back

تمري�ن 3: ش��کل 11-8 را با اس��تفاده از الگوهاي نمايش داده ش��ده، طراحي 
کنيد.

شکل 8-11

PostScript 8-2-5

به منظور پرکردن اش��کال با الگوهاي مبتني بر بردارهاي رياضي از PostScript اس��تفاده 
مي‌ش��ود. اش��کالي که با اين نوع طرح پر مي‌ش��وند؛ زماني قابل مشاهده مي‌شوند که با يک 
  Object در پنل Fill از منوي بازشوي انواع PostScript چاپ ش��وند. گزينه PostScript چاپگر

قابل انتخاب است.
Custom  8-2-6

اي��ن گزينه در منوي بازش��وي انواع Fill، قرار دارد که ليس��تي از الگوهاي آماده را براي 
پر کردن داخل ش��کل نش��ان مي‌دهد )شکل 12-8(. در اين صورت با انتخاب هر يک از اين 
الگوها، موضوع انتخاب ش��ده با آن پر مي‌ش��ود. همچنين رنگ الگوها را مي‌توانيد با انتخاب 
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رنگ از پنل Swatches تغيير دهيد.

 توجه: الگوهاي آماده گزينه Custom توس��ط مانيتور قابل ديدن نيس��تند و بعد از 

چاپ قابل مشاهده خواهند بود.

 Custom Fills 8-12 شکل

  Tiled  8-2-7

نوع ديگري از طرح‌هاي پرکننده که براي پرکردن موضوعات از ترس��يمات ديگر استفاده 
مي‌کند، گزينه Tiled است. همچنين گاهي اوقات در طراحي لازم است که يک شکل از قبل 
طراحي ش��ده در داخل يک طرح ديگر تکرار ش��ود مانند جعبه دستمال کاغذي، کاغذ کادو، 
س��اک دس��تي يا تکرار آرم يک ش��رکت در زمينه برگه‌هاي تبليغاتي آن شرکت و نيز موارد 

ديگر.
براي ايجاد و اعمال اين پرکننده مراحل زير را انجام دهيد:

1- ش��کلي را که مي‌خواهيد جهت تکرار در موضوع ديگر اس��تفاده کنيد، ترسيم کرده و 
.)Ctrl+C( از آن کپي بگيريد

 توجه: مي‌توانيد يک متن را نوشته، سپس به موضوع تبديل کرده و در شکل ديگر 

تکرار کنيد.
1- موضوعي که مي‌خواهيد باTiled  پر شود، انتخاب کنيد.

2- از منوي بازش��وي ان��واع Fill  گزينه Tiled را برگزيني��د و روي دکمه Paste in  کليک 
کنيد. ش��کل کپي شده در کادر پيش نمايش ظاهر ش��ده و موضوع با آن پر مي‌شود )شکل 
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.)8-13
3- براي تغيير اندازه پرکننده Tiled از کادرهاي x و y در قسمت مقياس)Scale( استفاده 
کنيد، با دادن مقادير کوچک‌‌تر يا بزرگ‌تر از 100 ابعاد پرکننده کوچک‌تر يا بزرگ‌تر مي‌شود. 
ب��ه منظور تغيي��ر مقياس يکنواخت پرکنن��ده، در هر دو کادر x  و y مقادير يکس��اني به‌کار 

بريد.
 y و x 4- ب��راي جابه‌ج��ا کردن پرکننده مي‌توانيد مقادير مثبت و منف��ي را در کادرهاي

مربوط به Offset وارد کنيد.

              

شکل 13-8 گزينه Tiled و نمونه‌اي از تأثير آن

5- براي زاويه‌دار کردن پرکننده يا چرخش آن مي‌توانيد از اهرم چرخش اس��تفاده کنيد 
يا زاويه دقيق را در کادر Angle وارد کنيد.

 نكته: طرح‌هاي پرکننده Tiled حتماً بايد برداري باش��ند و شامل تصاوير گرافيکي 
پيکسلي نمي‌شوند.

تمرين 4: کاغذ کادو نشان داده شده در شکل 14-8 را به ابعاد 18×30 سانتي‌متر 
طراحي کنيد.
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شکل 8-14

Lens 8-2-8

با استفاده از اين پرکننده مي‌توان ظاهر شکل را با معکوس کردن رنگ‌ها، تغيير شفافيت، 
رنگ، روشني، تيرگي يا بزرگنمايي تغيير داد.  

براي اعمال اين پرکننده مراحل زير را انجام دهيد:
1- گزينه Lens )لنز( را از منوي بازشوي انواع Fill انتخاب کنيد، در اين صورت گزينه‌هاي 

تنظيمي آن ظاهر مي‌شود )شکل 8-15(.

شکل 15-8 گزينه‌هاي پر کننده عدسي

2- يکي از شش نوع پرکننده Lens را به دلخواه انتخاب نماييد.
ب��ا توجه به نوع لنز انتخاب ش��ده گزينه‌هاي متفاوتي ب��ه منظور تغيير تنظيمات نمايش 
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داده مي‌شوند.
3- براي‌ لنزهاي Transparency و Monochrome با استفاده از منوي بازشو با کادر رنگ، 

مي‌توان رنگي را انتخاب نمود.
4- در‌ لنز Magnify براي تنظيم بزرگنمايي شکل زير لنز مقدار بين 1 تا 20 را وارد کرده 

يا دكمه لغزنده را جهت تنظيم مقدار درگ نماييد.
5- در‌ لنزه��اي Lighten ،Transparency و Darken با وارد نمودن مقادير دلخواه يا درگ 

کردن دكمه لغزنده مي‌توان تنظيمات زير را انجام داد:
• )کاملًا  براي پر کننده Transparency، حدود مقادير بين صفر )کاملًا شفاف( تا 100	

کدر( مي‌باشد )شكل 8-16(.
• مس��ير لنز را از س��فيد کاملًا  براي پر کنندهLighten ، مقدار صفر، بي‌اثر و عدد 100	

پر مي‌کند )شكل 8-17(.
• مس��ير لنز را از مشکي کاملًا  براي پر کنندهDarken ، مقدار صفر، بي‌اثر و عدد 100	

پر مي‌کند )شكل 8-18(.

                   

شکل 16-8                       شکل 17-8                             شکل 8-18

به‌منظ��ور نمايش دس��تگيره در مرکز لنز انتخاب ش��ده، گزين��ه Centerpoint را انتخاب 
نماييد در اين صورت با استفاده از ابزار Pointer مي‌توانيد نقطه مرکز را جابه‌جا كنيد.

 نكته: به منظور بازگرداندن نقطه مرکز به مرکز لنز کليد Shift را پايين نگه داشته 
و روي نقطه کليک كنيد.

انتخاب گزينه Objects Only باعث مي‌شود تا لنز مورد نظر تنها روي شکل انتخاب شده 
تأثير داشته باشد و روي نواحي انتخاب نشده تغييري ايجاد نکند.

انتخاب گزينه Snapshot باعث مي‌شود تا زماني که روي هر قسمت از شکل انتخاب شده 
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لنز را قرار دهيد، تصويري از آن قسمت گرفته شود.
کليک کنيد، پرکننده داخل موضوع  • 	 Object در زبانه Remove Item اگ��ر روي دکمه

حذف مي‌شود.
تمرين 5: ش��کل 19-8 را رسم كنيد و قس��متي از آن را به‌صورتي که در شکل 

مشاهده مي‌نماييد طوري تصويربرداري كنيد که بزرگ‌تر نمايش داده شود.

شکل 8-19

Object در پنل Add Stroke 3-8 دکمه
منظور از Stroke ضخامت خطوطي است که دور موضوعات را احاطه مي‌کند، Stroke نيز 
يکي از زير مجموعه‌هاي پنل Object اس��ت که خطوط دور مسيرها را کنترل مي‌کند )شکل 

.)8-20

Object در پنل Stroke شکل 20-8 گزينه‌هاي

در منوي بازش��وي انواع Stroke علاوه بر گزينه Basic، طرح‌هاي ديگري نيز براي رس��م 
خط��وط دور مس��يرها وج��ود دارد که همه اين خطوط با اس��تفاده از پن��ل Swatches قابل 

رنگ‌آميزي هستند.
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 )Stroke( نحوه استفاده از خط دور
1- تصوير دلخواهي رسم کرده و آن را انتخاب کنيد. 

2- روي دکمه Add Stroke از پنل Object کليک کنيد.

3- از من��وي بازش��وي انواع Stroke يک��ي از گزينه‌هاي Stroke را انتخاب کنيد )ش��کل 
21-8( که در اين صورت، تنظيمات پنل Object براس��اس نوع خط دور انتخاب شده، تغيير 

مي‌کند.      

Stroke شکل 21-8 گزينه‌هاي منوي

 Basic 1-3-8 گزينه

با نسبت دادن رنگ از پنل Swatches به دور موضوعات، خطوط با رنگ ساده رنگ‌آميزي 
مي‌شوند. 

 توج�ه: با اس��تفاده از جعبه رنگ  Stroke در جعبه اب��زار Tools نيز مي‌توانيد رنگ 

خط دور را انتخاب کنيد.
Stroke گزينه‌هاي کنترلي خطوط مرزي موضوعات در

• ب��ا کليک روي مربع رنگي، امکان انتخاب هم��ه رنگ‌ها براي خط دور  جعب�ه رنگ:	
مسير فراهم مي‌آيد؛ همچنين با باز کردن منوي بازشوي کنار آن، رنگ‌هاي موجود 

در پنل Swatches نشان داده مي‌شوند.
هاي زيري��ن آن ادغام  • Overprint: ب��ا انتخ��اب اين گزين��ه رنگ خط دور ب��ا رنگ‌	

مي‌شود.
• با انتخاب ان��دازه موردنظر برحس��ب واحد  	:Width من�وي بازش�و
اندازه‌گيري صفحه، از ليس��ت موجود در اين قس��مت مي‌توانيد ضخامت خط دور را 

تغيير دهيد يا عددي بين صفر تا Point( 288( را در کادر مربوطه تايپ کنيد.
• وضعي��ت انتهاي خطوط‌مس��ير يا نوع گوش��ه‌هاي خط را  	:  Cap

تعيين مي‌کند.
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  Capانواع شيوه‌هاي
• Butt: انتهاي خط دور را با خط مستقيم پايان مي‌دهد.	

• Round: انتهاي خط دور را با منحني ختم مي‌کند.	

• Square: انتهاي خط دور را با مربع پايان مي‌دهد.	

                                            

شکل 22-8 انواع شيوه‌هاي Cap اعمال شده به مسير

• وضعيت و ش��کل محل تلاقي پاره‌خط‌ها با يکديگر در اين  	:  Join

قسمت تعيين مي‌شود.

 توجه: براي ديدن تفاوت‌هاي موجود در انواع ش��يوه‌هاي Join، بزرگنمايي خط يا 

عرض خط دور را افزايش دهيد.

 Join انواع شيوه‌هاي
براي اعمال هر کدام از شيوه‌ها روي آيکن مربوطه کليک کنيد )شکل 8-23(. 

شکل 23-8 شيوه‌هاي Join اعمال شده به مسير

• Miter: در محل تقاطع دو پاره‌خط، گوشه نوک تيز ايجاد مي‌کند.	

• Round: در محل تلاقي دو پاره‌خط، منحني تشکيل مي‌دهد.	

• Bevel: محل تلاقي دو پاره‌خط را برش مي‌زند، اصطلاحاً پخ مي‌کند.	

• )نوع تيز(  	Miter وقت��ي براي نقاط تلاق��ي پاره‌خط‌ها، گزينه :  Miter

انتخاب مي‌شود؛ عدد داده شده دامنه کشش تيزي را تعيين مي‌کند.
• ب��ا اس��تفاده از اين من��وي بازش��و مي‌توانيد  	:Dash ان�واع 
 ان��واع خ��ط را از لح��اظ خط‌چين ي��ا نقطه‌چين ي��ا ترکيب��ي از اي��ن دو و .... تعيين کنيد

)شکل 8-24(.
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Arrowheads و dash شکل 24-8 انواع

با استفاده از اين منوي بازشو مي‌توان انواع پيکان‌ها را  • 	 :Arrowheads منوي بازش�و
براي ابتدا و انتهاي خط انتخاب شده، تعيين کرد. 

Brush 2-3-8 گزينه

با اس��تفاده از اين گزينه مي‌توان نوع خط دور را بر اس��اس ان��واع قلم‌هاي موجود تغيير 
داد. اي��ن قلم‌ه��ا قبلًا توس��ط فرمان Brush در من��وي Modify ايجاد ش��ده‌اند و داراي انواع 
طرح‌هاي گرافيکي زيبا هس��تند. اين قلم‌ها در منوي بازشوي مربوطه که شامل انواع طرح‌ها 

و الگوهاست قابل مشاهده و انتخاب هستند.
بعد از انتخاب قلم موي موردنظر، مي‌توانيد براي انتخاب نمونه‌هاي ديگر قلم روي دکمه 

Options کليک کنيد تا منويي مطابق شکل 25-8 باز شود.

Options شکل 25-8 منوي مربوط به دکمه
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با انتخاب گزينه Import مي‌توانيد از ليس��ت فايل‌هاي مربوط به قلم‌هاي آماده يك فايل 
را انتخاب كنيد.

در کادر محاوره Import Symbols مي‌توانيد قلم مورد نظر را انتخاب و وارد ليست مجموعه 
قلم‌ها کنيد. حال خطوط دور شکل انتخاب شده با طرح قلم انتخابي طراحي مي‌شود )شکل 

.)8-27
: اين گزينه براي تعيين اندازه قلم به‌کار مي‌رود.

 نكته: مي‌توانيد با استفاده از گزينه New مربوط به دکمه Options يک قلم جديد 
تعريف کنيد.

  

Brush شکل 26-8 کادرانتخاب نوک قلم‌مو                                 شکل 27-8 نحوه تأثير گزينه

 نكته: براي تبديل يک موضوع ترسيمي انتخاب شده، به قلم‌مو کافي است فرمان 
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زير را اجرا کنيد:
Modify→Brush→Create Brush 

Custom 3-3-8 گزينه

اين گزينه امکان انتخاب‌مدل‌ها و شکل‌هاي‌آماده را براي خطوط دوراشکال فراهم‌مي‌سازد 
)شکل 28-8(. اين مدل‌ها در مانيتور قابل مشاهده نيستند و فقط در چاپ ديده مي‌شوند. 
• بلندي يا طول ش��کل‌هاي آماده را تعيين مي‌کند و کادر  	Length در اين بخش کادر

Spacing فاصله بين شکل‌‌هاي آماده Custom را تنظيم مي‌کند.

Stroke در انواع Custom شکل 28-8 گزينه

Pattern 4-3-8 گزينه

الگوهاي از قبل آماده‌اي هس��تند که مي‌توانيد آن‌ها را ويرايش کرده و به صورت دلخواه 
درآوريد و به لبه‌ها و خطوط دور موضوعات نسبت دهيد.

 Postscript 5-3-8 گزينه

 اين گزينه به ش��ما امکان مي‌دهد تا از الگوهاي مبتني بر بردارهاي رياضي براي خطوط 
دور اشکال استفاده کنيد.

 نكت�ه: ب��ا انتخاب گزين��ه   از پن��ل Swatches، خ��ط دور مس��ير )Stroke( حذف 
مي‌شود.

تمرين 6:
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1- شکل 29-8 را طراحي کرده و به عنوان قلم‌مو تعريف کنيد.  
2- براي افزايش مهارت کار با انواع Stroke، شکل 30-8 را رسم کنيد. 

           

                                         شکل 29-8                                       شکل 8-30

      Eye Dropper4-8 ابزار
اين ابزار براي نمونه‌برداري از رنگ موضوعات و اس��تفاده در رنگ‌آميزي موضوعات ديگر 

کاربرد دارد.
تمرين 7: از رنگ قس��مت دلخواه شکل 31-8 )سمت چپ( نمونه‌برداري کرده و 

شکل سمت راست را با آن رنگ کنيد. 

شکل 31-8 نمونه برداري از رنگ شکل

Create 5-8 فرمان
با اس��تفاده از فرمان‌هاي موجود در من��وي Xtras مي‌توانيد روي كار جلوه‌هايي به وجود 
آوريد كه كار زيباتر به نظر برس��د. اين منو شامل س��ه فرمان Emboss ، Blend و Trap است 

)شكل 8-32(.

Create شكل 32-8 فرامين موجود در منوي
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Blend 1-5-8 فرمان

از اين فرمان براي ترکيب کردن يا به هم رس��اندن دو موضوع انتخابي اس��تفاده مي‌شود. 
چون اين فرمان از گزينه‌هاي Combine نيز است بنابراين در واحد كار 10 با جزييات بيشتر 

آن آشنا خواهيد شد.
Emboss 2-5-8 فرمان

با اس��تفاده از اين فرمان مي‌توان انواع جلوه‌هاي برجسته‌سازي را روي موضوعات انتخاب 
شده نمايش داد.

Emboss روش كار با فرمان
1- موضوع گرافيكي مورد نظر را انتخاب كنيد.

2- فرم��انXtras→Create→Emboss  را اجرا كنيد. كادر محاوره Emboss مطابق شك��ل 
33-8 ظاهر مي‌شود.

3- از پنج نوع جلوه مربوط به برجس��تگي كه ش��امل Ridge ، Chisel، Deboss، Emboss و 
Quilt مي‌شود، يكي را انتخاب كنيد )شكل 8-34(.

 Emboss شكل 33-8 كادر محاوره

شكل 34-8 انواع برجستگي

4- در شك��ل 35-8 نتيجه حاصل از تأثير انواع جلوه‌هاي برجس��تگي نش��ان داده شده 



Free Hand پیمانه مهارتی : کاربر
211واحد کار هشتم: توانایی استفاده از پرکننده ها و فرمان های ویرایش اشیاء

است.
5- در منوي بازشوي Vary دو گزينه Contrast وColor  قرار دارد )شكل 8-36(.

    

Vary شكل 35-8 نتيجه حاصل از تأثير انواع جلوه‌هاي برجستگي            شكل 36-8 گزينه

6- کادر و دکم��ه لغزن��ده Depth عمق فرورفتگي يا ضخامت برجس��تگي را در لبه‌هاي 
موضوع گرافيكي انتخاب شده تعيين ميك‌ند.

7- با استفاده از کادر Angle مي‌توانيد سايه را با زاويه دلخواه‌ روي‌شكل ايجاد كنيد.
8- انتخ��اب گزينه Soft Edge باعث مي‌ش��ود ک��ه جلوه برجس��تگي در لبه‌هاي موضوع 

گرافيكي انتخاب شده، هموارتر و نرم‌تر نشان داده شود.
9- براي مش��اهده نحوه تأثيرگذاري تنظيمات روي موضوع گرافيكي انتخاب شده، روي 

دكمه Apply كليك كنيد و اگر از نتيجه راضي هستيد روي دكمه OK كليك كنيد.

 مثال 2: شكل 37-8 را رسم كنيد و به آن برجستگي با سايه‌اي به رنگ قرمز و 
		 لبه‌هاي نرم و هموار بدهيد.

شكل 8-37

پس از رسم، براي دادن جلوه برجستگي به شكل ابتدا آن را انتخاب كنيد، سپس فرمان 
 Vary در منوي‌ بازش��وي Emboss را اج��را كنيد. در كادر محاوره Xtras→Create→Emboss



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - هـ
212

گزينه Color را انتخاب كنيد و رنگ را در قس��متShadow  مطابق شك��ل 38-8 قرمز قرار 
دهيد. براي هموار بودن سايه بايد گزينه  Soft Edge فعال باشد.

                                                                                                                                                                                                                                 

شكل 38-8 تنظيم رنگ قرمز براي ايجاد سايه                  شكل 8-39

Trap 3-5-8 فرمان

اين فرمان هنگام چاپ گرفتن از يک کار، اس��تفاده مي‌ش��ود. زماني که تصويري با رنگ 
سياه روي تصاوير رنگي ديگر قرار گرفته باشد، اين فرمان رنگ‌هاي زير ناحيه سياه را حذف 

مي‌کند به صورتي که در مصرف جوهر پرينتر صرفه‌جويي مي‌شود.
همچنين اين فرمان رنگ‌ها را به شكل مناسب روي هم قرار مي‌دهد به طوري كه هنگام 

چاپ، زمينه كاغذ معلوم نباشد. 

Trap شكل 40-8 كادر محاوره

Distort 6-8 فرمان
زيرمن��وي Distort ش��امل دو فرمان Add Points و Fractalize اس��ت كه به منظور اضافه 
کردن گره‌هاي جديد روي مسير و تغيير شكل دادن موضوعات گرافيكي انتخاب شده به كار 

مي‌روند )شكل 8-41(.
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Distort شكل 41-8 گزينه

Add Points 1-6-8 فرمان

با اجراي اين فرمان مي‌توانيد تعداد گره بيش��تري به مس��ير يا موضوع گرافيكي انتخاب 
شده، اضافه كنيد.

براي استفاده از فرمان Add Points مراحل زير را انجام دهيد:
1- موضوع دلخواهي را انتخاب كنيد.

2- فرمـان Xtra→Distort→Add Points را اجـرا كنيد يا روي ‌آيكـن  از نـوار ابزار
Xtra Operations كليك كنيد.

در اي��ن ص��ورت نقاط جديدي بي��ن يك جفت از نقاط موجود اضافه مي‌ش��ود )شك��ل 
.)8-42

Add Points شكل 42-8 شكل سمت راست، نتيجه اجراي فرمان

Fractalize 2-6-8 فرمان

ب��ا اس��تفاده از اين فرمان مي‌توان الگوهاي س��اده يا پيچيده‌اي را ايج��اد كرد. معمولاً از 
اجراي مكرر فرمان Fractalize روي يك موضوع، الگوهاي جالبي ايجاد مي‌شود.

 مثال 3: 1- يك ستاره مطابق شكل 43-8 رسم و آن را انتخاب كنيد.

شكل 43-8 رسم و انتخاب شكل

 2- فرم��ان Xtras→Distort→Fractalize را 3 ب��ار اجرا��كرده و نتيجه‌را مش��اهده ك‌نيد 
)شكل 8-44(.
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Fractalize شكل 44-8 نتيجه 3 بار اجراي فرمان

تمرين 8: شكل 45-8 را رسم كرده و فرمان Fractalize را 5 بار روي آن اعمال 
كنيد.

 
شكل 8-45

 مث�ال كاربردي: در ادامه مثال كاربردي واحد كار پيش��ين مراحل زير را انجام 

دهيد:
1- اکنون براي ايجاد كارت ويزيت صفحه جديدي باز كنيد. 

2- ابعاد كارت ويزيت 5×9 سانتي‌متر است، اما چون مي‌خواهيم واحد صفحه را ميلي‌متر 
در نظر بگيريم، ابعاد صفحه را به‌صورتw = 50 وh = 90 وارد کنيد. 

3- با اس��تفاده از ابزار Zoom صفحه را در حال��ت بزرگنمايي قرار دهيد تا كار در صفحه 
براي شما آسان‌تر شود.

     ، w = 50 و  h = 7 ،Object 4- چهارگوش��ي در صفحه رس��ـم كنيد و ابعـاد آن را در پنل
x =0 و y = 83 قرار دهيد، سپس داخل چهارگوش را با رنگ سياه پر كنيد.

شكل 8-46
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5- تغييرات را در فايلProject.fh11  ذخيره كنيد.
واژه‌نامه

Bevelکج کردن، اريب

Blendآميختن، مخلوط‌کردن 

Brushقلم‌مو

Combineترکيب‌کردن

Coneمخروطي‌شکل‌کردن

Eye dropperقطره‌چکان

Gradientطيف رنگ

Hatchهاشورزدن

Lensلنز، عدسي

Magnifyذره‌بين

Miter limitگردکردن خط

Patternالگو

Reductionکاهش

Removeحذف‌کردن

Transparencyشفافيت

خلاصه مطالب 

• براي پر کردن رنگ داخل موضوعات و مسيرها استفاده  	Object در پنل Fill از گزينه
مي‌شود.

• ب��راي رنگ‌آميزي خط دور و محتواي داخ��ل موضوعات انتخابي به‌کار  	Basic ط��رح
مي‌رود.

، طيف رنگي اس��ت که از يک رنگ ش��روع و به‌رنگ‌هاي ديگر  • 	Gradient منظ��ور از
تبديل مي‌شود.

• تصاوير گرافيکي آماده‌اي هس��تند که به موضوعات نماي بافت  	Textured پرکنن��ده
مي‌دهند. 
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، الگوهايي هس��تند که مي‌توانيد در ترسيمات به جاي رنگ از  • 	Pattern پرکننده‌هاي
آن‌ها استفاده کنيد. 

 • 	Tiled ليستي از الگوهاي آماده را براي پر کردن داخل شکل و گزينه Custom گزينه
از طرح‌هاي پرکننده است و زماني به كار مي‌رود که در طراحي لازم است يک شکل 

از قبل طراحي شده در داخل يک طرح ديگر تکرار شود.
•با اس��تفاده از پر کننده لنز مي‌توان ظاهر ش��کل را با معکوس کردن رنگ‌ها، تغيير  	

شفافيت، رنگ، روشني، تيرگي يا بزرگنمايي، تغيير داد.  
• منظور از Stroke ضخامت خطوطي است که دور موضوعات را احاطه مي‌کند.	

• براي نمونه‌برداري از رنگ موضوعات و اس��تفاده در رنگ‌آميزي  	Eye dropper اب��زار
موضوعات ديگر کاربرد دارد.

• مي‌توان انواع جلوه‌هاي برجسته‌سازي را روي موضوعات  	Emboss با استفاده از فرمان
انتخاب شده نمايش داد.

رنگ‌ها را به شك��ل مناس��ب روي هم قرار مي‌دهد به طوري كه هنگام  • 	Trap  فرمان
چاپ،  زمينه كاغذ معلوم نباشد.
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آزمون نظري
درستي يا نادرستي گزينه هاي زير را تعيين کنيد.

1- پرکنن��ده Gradient تصاوي��ر گرافيک��ي آماده‌اي هس��تند که به ج��اي دادن رنگ به 
موضوعات به آن‌ها نماي بافت مي‌دهند.

2- از گزينه Fill براي پرکردن رنگ داخل موضوعات و مسيرها استفاده مي‌شود.
3- اب��زار Eye dropper ب��راي نمونه‌برداري از رنگ موضوعات و اس��تفاده در رنگ‌آميزي 

موضوعات ديگر کاربرد دارد.
4- طيف مخروطي مانند طيف رنگ خطي اس��ت؛ با اين تفاوت که تغيير رنگ‌ها به طور 

نامساوي صورت مي‌گيرد.
معادل گزينه هاي سمت ‌راست را از ستون سمت ‌چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

5- با انتخاب اين نوع Gradient، رنگ داخل موضوع انتخاب شده از مرکز شروع مي‌شود 
و يک کره ايجاد مي‌کند. اين شيب يک شيب مدور است.                           شيب تابعي

6- تغيير رنگي که در اين نوع Gradient اعمال مي‌ش��ود براساس شکل مسيري است که 
انتخاب کرده‌ايد.                                                                            شيب کروي
  Trap      .7- با استفاده از اين فرمان مي‌توان الگوهاي ساده يا پيچيده‌اي را ايجاد كرد
                                  Fractalize                 .8- اين فرمان هنگام چاپ گرفتن از يک کار، استفاده مي‌شود

گزينه صحيح را انتخاب کنيد.

9- در قسمت Fill براي پرکردن مسير انتخاب شده از الگوهاي آماده، کدام گزينه استفاده 
مي‌شود؟

Postscript -ب 		 Tiled -الف
Pattern -د 		 Gradient -ج

 Fill 10- ب��راي اعمال طيف رنگي در داخل اش��کال انتخاب ش��ده از ک��دام گزينه انواع
استفاده مي‌شود؟

 Gradient-ب 		 Basic -الف
 Postscript  -د 		 Textured -ج
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11- کدام‌يک از پرکننده مسيرها روي صفحه نمايش ديده نمي‌شود؟
 Pattern-ب 		 Textured -الف

د- گزينه‌هاي الف و ج صحيح هستند. 		 Custom -ج
12- گزينه Cap در قسمت Stroke چه کاربردي دارد؟

ب- تعيين گردي گوشه‌هاي موضوعات  الف- تعيين نوع زاويه بين دو خط	
د- تعيين رنگ انتخابي خطوط در مسيرها  ج- تعيين وضعيت انتهاي خطوط	

13- براي رنگ برداري از کدام ابزار استفاده مي‌شود؟
Stroke -د   	  Postscript -ج 	Lens  -ب 	 Eye Dropper-الف

14- کدام نوع Gradient در شکل زير به‌کار رفته است؟
الف- خطي   
ب- تابعي   	
ج- کروي    
د- مخروطي

در جاي خالي عبارت مناسب را بنويسيد.

15- ضخامت خطوطي كه دور موضوعات را احاطه كرده است .............. ناميده مي‌شود.
16- از فرم��ان ........................ ب��راي ترکيب کردن يا به هم رس��اندن دو موضوع انتخابي 

استفاده مي‌شود.
17- با استفاده از فرمان Emboss مي‌توان ................. را روي موضوعات نمايش داد.

به سؤالات زير پاسخ تشريحی دهيد.

18- براي حذف ضخامت خطوط مسيرها چه بايد کرد؟
19- چگونه مي‌توان به جاي رنگ، موضوعات را از الگوها و بافت‌ها پر کرد؟

20- با انتخاب کدام گزينه مي‌توان قلم از قبل تعريف شده را به خطوط موضوعات نسبت 
داد؟

آزمون عملي
1- غروب خورشيد )در كنار دريا( را ترسيم كنيد و تأثير Lens را در آن بررسي كنيد.

2- براي شعر زير تصويرسازي كنيد. توجه داشته باشيد كه از انواع پركننده‌هاي گرافيكي 
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نظي��ر طيف رنگ، باف��ت، الگوهاي آماده، تكرار طرح، جلوه برجسته‌س��ازي و تغيير شك��ل 
موضوعات گرافيكي )Fractalize( در ترسيم استفاده كنيد.

دو تا كفتر
نشسته‌اند روي شاخه سدر كهنسالي

كه روييده غريب از همگنان در دامن كوه قوي پيكر
پس از اين كوه تشنه دره‌اي ژرف است،

در او نزديك غاري تار و تنها، چشمه‌اي روشن
ازينجا تا كنار چشمه راهي نيست.

                                                           "اخوان ثالث"
3- شكل يك دكمه )Button( را با عنوان START  براي شروع اجراي يك برنامه طراحي 

كنيد سپس با استفاده از جلوه برجستگي مناسب، فشرده شدن دكمه را نمايش دهيد.
4- شکل زیر را رسم کرده و به عنوان طرح روي جعبه دستمال کاغذي به ابعاد 20×30 

قرار دهيد.

5- طراحي برچس��ب )Label( روي CD را به‌طوري‌که در ش��کل نش��ان داده شده، انجام 
دهيد.


